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Introduction

System Requirements

Requires

An Atari ST, STe, Mega ST, TT or Falcon computer system.
Minimum 1Mb of memory.

Double-sided disk drive.

Recommended

Hard disk or second floppy drive for storage of images.

Additional memory, especially for animation or True Colour use.

Registration Card

Enclosed with this manual is a registration card which you should fill
in and return to us in order to register your purchase of TruePaint
This will entitle you to a free period of technical support and will
enable us to keep you informed of future developments to our
software.

For details of our technical support services, please refer to
Appendix D of this manual.

You will need to quote your serial number (to be found on the disk 1
label) to obtain technical support and you may find it useful to make
a note of it here:

Serial No. 3 _0)/5_‘?" / j ] —l
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Making a Working Copy

Before using TruePaint you should make backup copies of the
distribution disks and put the originals away in a secure place; safe
from extremes of temperature, magnetic fields, moisture and
children! The disks can be backed-up using the Desktop or any
backup utility - before making any backup always write-protect the
master to prevent accidental erasure.

Remember that your backup copies are for you only. The disks are
not copy-protected to allow easy backup and to avoid inconvenience.
Please respect this and do not give away copies to others. Not only is
this illegal and unfair, it seriously endangers software production and
puts prices up. If you make copies of TruePaint for your friends who
otherwise would have bought the program, we will not receive enough
revenue from the sale of the package to produce new versions.

The READ.ME File

As with all HiSoft products, TruePaint is continually being improved
and updated and the latest details may be found in the READ.ME file
ondisk 1. It is important that you read this to find out about any new
features or corrections to the manual. You can do this by double-
clicking on its icon from the Desktop and selecting Show.
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Using this Manual

We have designed this manual to contain all of the information you
need in order to learn how to use TruePaint whether you are a
complete beginner or an experienced computer artist. Of course you
don’t have to read all of it and to help you get the best out of the
package we have plotted a recommended course through the
manual.

Starting Off

First of all, you should at least browse through the following chapter.
In addition to giving details of how to install and run TruePaint, it
explains the different elements of the TruePaint window display. If
you are new to paint packages or computers in general then you will
find this section most useful; more experienced users will want to skip
over the parts they already know,

After this, you are ready to start drawing with TruePaint (in fact, if
experience is anything to go by, you probably already have!). If you
feel confident about it, go ahead and explore; you can look up any
options that you don’t understand in the Reference section and dip
into the tutorials to find out how various features work. Alternatively,
you may wish to work through the tutorials systematically to gain
familiarity with the program.

The Middle Bit

The Background chapter is for those interested in how it all works. It
contains lots of information about computer graphics to help you
understand how to make the most of them. You will probably want to
miss out this chapter initially and return to it later, maybe to find out
about a particular topic of interest.

Each of the Tutorials covers a particular aspect of drawing with
TruePaint. The first few explain the fundamentals, with later tutorials
describing more complex features, so they may be read in sequence.
The important thing is to follow them using the computer to
experiment as you go along. Advanced users can refer to individual
tutorials for further information and useful techniques as required. *

TruePaint

Introduction Page 3



Animation has a whole chapter to itself and this is where to look if you
want to make your pictures move. It assumes that you are already
familiar with the other aspects of TruePaint, so it is advisable to have
read at least some of the tutorials beforehand. As well as describing
the creation and editing of animated sequences, there is also some
practical advice and suggestions to get you started.

For Reference

The remainder of the manual is intended for reference (although you
can read through it if you want). Each of the drawing tools, options and
menu items are described in detail in the Reference chapter. If you
are unsure about a particular feature, perhaps when working through
one of the tutorials, turn to this section to find out exactly what it does.
It will also tell you about any related options and suggest where to
look for further details.

Finally, the Appendices contain information which you may find
useful, including a complete list of keyboard shortcuts which can be
used for speed, details of the various file formats supported by
TruePaint, and how to obtain téchnical support from HiSoft if you are
really stuck.

Good luck! We hope you find TruePaint a creative, flexible and
enjoyable tool to use. As always, we welcome any written comments
you may have on how we might improve both the program and the
manual.
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Getting Started

This chapter explains how to get TruePaint up and running, covering the
installation process and how to load and save pictures. It also contains a guide to
the TruePaint screen display to familiarise you with the user interface.

Running TruePaint

TruePaint is supplied on several double-sided disks which you should
backup before attempting to use the software. The program can be
run directly from your disk 1 backup or you can choose to install it on
another disk or a hard drive using the installation program described
later.

From Floppy Disk

To run TruePaint from floppy disk after starting up your computer
you should:

Insert your backup of disk 1 (or the disk onto which you installed
TruePaint) in your computer’s internal floppy disk drive (drive A).

Use the Desktop to change into the required video mode. To start
off with, we recommend that you use True Colour on the Falcon,
low resolution on an ST or STe, and TT low for the TT. See your
computer manual for details of how to do this.

Using the mouse, position the arrow pointer over the drive A icon
on the screen and double-click (press the left mouse button twice
in succession) so that a window containing various icons appears.

Now double-click on the TRUPAINT.PRG icon to start the
program.

After a short time, the screen should go blank and the word TruePaint
or TP will appear in the bar along the top. If this doesn’t happen then
check that you are doing everything correctly.

TruePaint
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Loading a Picture

The first thing to try is loading one of our example pictures. This can
be done as follows:

. Move the mouse pointer up to the word ‘File’ and then down over
‘Open’ and press the left mouse button once. A box should appear
for you to choose an image file.

. If you have a second floppy disk drive, insert the examples disk in
drive B.
. Click on the button marked ‘B’ at the right-hand side. This is

important even if you only have one drive $o that TruePaint knows
you are about to use another disk. Single drive users will be
prompted to swap disks at this stage and should insert the
example disk and click on OK.

. Now click on the PICTURES folder and when the list of pictures
appears, double-click on the one called EXAMPLE.JPG.

Users with one floppy drive should swap disks when asked to. Disk A
refers to the one containing TruePaint and disk B is the examples
disk.

The example picture is stored in the JPEG file format so that it can be
loaded into any video mode (although True Colour will give the best
results). However, this does cause the loading process to be slower
than normal due to the conversion required, so don’t worry if there is
a delay before the picture appears.

You are now ready to proceed with the rest of this chapter or start the
tutorials.
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Installing TruePaint

If you wish to use TruePaint from hard disk or customise your floppy
disks, perhaps to make use of the extra storage capacity of a high
density drive, you should run the supplied installation program.

The installation program will copy the files that you need to the
correct locations and set up TruePaint to use the new configuration.
You can select which parts of the package are to be installed and
where. If you are the sort of person who doesn’t like installation
programs writing to your disks, you can also view the list of files to be
copied and copy them yourself if you wish.

To install TruePaint you should:

Insert your backup of disk 1 in drive A and double-click on the
drive A icon from the Desktop.

Double-click on the TPINST.PRG icon to run the installation
program.

The program will first ask you if you wish to install on hard disk or
floppy disk. You should click on the appropriate button.

If you wish to change the default configuration that the program
has chosen for you, use the various controls on the installation
screen as described in the help display (obtained by clicking on
the Help button).

Click on the OK button to proceed with the installation. You can
also click on Show to see which files will be copied.

When prompted to swap disks during installation, just insert the
requested disk and click on OK. Note that the example pictures are
not normally copied when installing on floppy disk since this is how
they are supplied.

After completion, the installation program will show you the
READ.ME file containing the latest details about your version of
TruePaint; please read this! You are then ready to run the installed
TruePaint by double-clicking on its icon as before. If your version of
the Desktop supports it, you can also run TruePaint by dropping
picture files on its icon, or install it as an application which runs
automatically when an image file is double-clicked. See your
computer manual for details.

TruePaint
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By default, floppy disk installation also formats a standard 720K
double-sided disk for you or a high density disk on the Falcon. If you
wish to use a different disk format (e.g. 800K) then you should format
a suitable floppy prior to running the installer and you must use the
volume name TRUPAINT for this disk. The automatic formatting can
be switched off from the installation screen.

We strongly suggest that you use the default setup recommended by
the installation program for your hardware configuration until you
become sufficiently familiar with the package to re-configure it to suit
your individual requirements.
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The Screen

To help you find your way around TruePaint we have included a quick guided
tour around the screen display, explaining what each element is for and how to

use it.

Windows

Each TruePaint window holds a single picture. This might be a file
which you have loaded from disk or a new image created within
TruePaint. You can have as many windows or pictures open as
memory permits (or the operating system allows).

~[=
e | R
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LA .

a TruePaint window

Since TruePaint windows are very much like the windows used by the
GEM Desktop, with a few additions described in the next section, you
may want to skip this part if you are already used to working with
them.

There is only ever one ‘active’ window, indicated by a different
coloured title bar and border. The active window is always situated in
front of all other windows.

In order to use a different window you can move the mouse pointer
over it and press the left mouse button once to activate it and bring it
to the top. If the window is hidden then you may need to move or
resize other windows first.

TruePaint
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The Title Bar

The title bar at the top of the window contains the window name. This
will be a filename if the picture was loaded from disk or ‘Untitled’
followed by a number for a new image. To move the window, place the
mouse pointer over the title bar and, holding down the left mouse
button, drag the window to a new position.

The Close Box

The close box is the button at the top left corner of each window.
Clicking on it will shut down the window. TruePaint will always ask if
you want to save your work to disk before closing a window since
otherwise it will be lost.

The Full Box

At the top right of the window is the full box. Clicking this button is a
quick way of enlarging the window to fill the screen. Clicking a second
time will restore it to its former size.

The Sizing Box

To change a window’s size you can also use the sizing box at the
bottom right corner. Position the pointer over it, hold down the left
mouse button and move the mouse so that a box appears. You can
use this to adjust the window size before releasing the mouse button.

The Drawing Area

Most of the window is taken up by the drawing area. This simply
shows part of the image and is where all of the actual drawing takes
place (not surprisingly!). When the mouse pointer is over the drawing
area it changes from an arrow to a crosshair for accurate positioning.

You will sometimes see a shaded background area past the edges of
the picture which you cannot draw on. This happens when the
drawing area is larger than the image being displayed.
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The Scroll Bars

At the right and bottom edge of each window are scroll bars. Since
images can be larger than the display area, the scroll bars allow you to
move around the picture and view different parts of it. You can also do
this by holding down the Alternate key, pressing the left mouse
button over the drawing area and moving the mouse. In this case, the
pointer will change to a hand graphic.

Clicking over an arrow button reveals more of the image in that
direction. You can hold down the mouse button to move a number of
steps until you release the button to stop. Pressing the cursor keys on
the keyboard has the same effect.

Pressing the mouse button over the scroll bar ‘handle” and dragging it
allows you to locate any part of the image quickly. Its size represents
how much of the whole image is currently in view. Clicking on the
background of a scroll bar can also be used to see the next ‘page’ of
the image and is the same as pressing a cursor key whilst holding
down the Shift key. -

Full Screen Mode

Although drawing normally takes place in a window, TruePaint also
allows you to switch into a Full Screen mode where there are no
window borders and the whole display is used for drawing.

This is very useful for working with large areas of the picture although
only a single image can be on screen at a time. To switch between Full
Screen and window displays, press the Clr Home key.

TruePaint

Getting Started Page 11



The Toolbox

At the side of each TruePaint window is a collection of icons called the
toolbox. Each icon represents a different ‘tool” which can be used for
drawing, '

the toolbox

In fact the toolbox can show-three different displays: drawing tools,
colours and patterns (plus another one in Zoom mode). The three
icons always present at the top of the toolbox indicate which display is
currently visible.

A co-ordinate display above the toolbox may also be obtained,
showing the exact co-ordinates of the mouse pointer on the image,
although by default this feature is turned off.

Drawing Tools

The normal toolbox display is the drawing tools. To select a drawing
tool simply move the mouse pointer over the appropriate icon and
click the left mouse button once. The icon will become highlighted to
show that it is in use.

Drawing tools affect what happens when you use the mouse inside
the drawing area. They each create a different sort of line, shape or
effect. If you draw something by mistake, you can always press the
Undo key to erase it again.

See the Reference and Tutorial sections for descriptions of the various
tools.
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Tool Atiributes

Many of the tools have a number of settings associated with them, the
thickness of a line for example. In these cases, double-clicking
(pressing the left mouse button twice in succession) over the toolbox
icon will reveal a Tool Attribute window which allows you to adjust
these settings.

Start: End: Thickness:
Square Square [+]
Arrod ArroW
Rounded Rounded

=]

Line Pattern:

[Cancer] [Thmfw') [T ]

a Tool Attribute window

Most of these windows, or dialog boxes as they are known in GEM
speak, have three buttons marked Cancel, Apply and OK. If you
accidentally change some attributes, clicking on the Cancel button
will leave the settings as they were before the dialog box appeared.

Clicking on OK or the close box accepts the changes and closes the
dialog. Note that this button has a dark border around it which means
that pressing the Return key has the same effect as clicking on the
button.

One important feature about TruePaint dialogs is that unlike those of
many other GEM programs, they do not block the drawing window.
The Apply button allows you to use the new settings for drawing
without closing the dialog box. You can then simply move it out of the
way and continue drawing with the dialog box remaining on screen for
easy access.

Each TruePaint dialog box is described in detail in the Reference
section under the relevant tool or menu item.

TruePaint
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Keyboard Shortcuts

Each tool and attribute dialog also has a keyboard shortcut associated
with it which provides an alternative to using the mouse. Keyboard
shortcuts have exactly the same effect as clicking on the icon; their
use is completely optional. You will probably find you make more use
of these as you become familiar with TruePaint.

Tool keyboard shortcuts are always single key presses and may be
used from Full Screen mode. Associated tool attribute dialogs can be
obtained by holding down the Shift key and then pressing the
relevant tool shortcut. A complete list of shortcuts can be found in
Appendix A.

The Palette Display

The second of the three toolbox displays is the palette display, used to
choose drawing colours. Click on the Palette icon at the top of the
toolbox to reveal this and choose a colour by simply clicking on it. You
can then either continue drawing or select the Drawing Tools icon to
return to the original toolbox display.

The actual palette display obtained depends upon which screen
mode TruePaint is running in. It will be different for palette modes
and True Colour. See Background and the Colour tutorial for details.

The Pattern Display

Finally, the pattern display is used to select different patterns for
drawing and filling shapes. You can also create your own
multicoloured patterns and textures with it. The pattern display is
described in detail in the Reference section.
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The Menus

The menu bar appears along the very top of the TruePaint screen.
There are many options and dialog boxes which can be accessed via
the menus.

Normally, the menus themselves are hidden but when you move the
mouse pointer over one of the menu titles at the top of the display, a
box containing the list of menu items drops down.

v Free Form ®E
v Filled Shapes &F
Rounded Boxes ©B

Rainbou ]
beneral... o]
Colour... ®e
Shadow. .. o |

Animation...

s e s soe o soe e Snt e s 2ot 200 i 20 Wb o o w0

Save Setup

the Options menu

To choose a menu item, simply move the mouse over it (a highlighted
bar will appear) and press the left mouse button once. Alternatively
you can click outside the box to dismiss the menu.

Menu items aré grouped by topic. The File menu contains all the
functions which deal with disk files and windows. The Edit menu
allows you to cut and paste parts of a picture and also contains the
vital Undo option!

The View menu controls various window display features, Options
gives access to settings and dialog boxes, Effects work on a selected
section of the picture. The very first menu, TruePaint or TP in low
resolution, is the Desk menu which contains any installed desk
accessories.

Choosing a menu item will normally carry out an action although
some produce a dialog box, enable various features etc. Each of the
menu options is described in detail in the Reference section.

TruePaint
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Ghosted Items

You will find that some menu items, Cut and Copy on the Edit menu
for example, often appear ‘greyed’. This effect is called ghosting and
it happens when it is not possible to use a menu item for some reason;
in the above case because you have not yet selected an area to work
with. See the Reference section if you are unclear as to what is wrong.

Items Ending In “...”

i r

Some items end in which means that selecting the option will
produce a dialog box containing settings or requesting further
information before any action is carried out. These are always safe to
choose since you can Cancel the dialog box if you wish. Items without
‘..." take effect immediately, possibly altering your picture.

Switches

A number of the items in various menus can have a tick or check
mark next to them indicating that the option is currently in use. In
most cases, selecting the menu item simply switches the option on or
off. '

Keyboard Shortcuts

As with the drawing tools, most menu items have keyboard shortcuts
which provide a‘quick way of accessing them. These are listed next to
the menu options; a complete list can be found in Appendix A.

Menu shorteuts often require two keys to be held down. This is
indicated in the menu by a special symbol. Those beginning with #
require Control to be held down before pressing the letter whilst &
denotes the Alternate key. Single key presses are enclosed in square
brackets like this: [M].
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Saving Your Work

You will probably want to keep your pictures and to do this you must
save them to disk. This is a good idea not only for posterity but as a
safeguard against mistakes, loss of power, hair etc. If you save your
work every so often then you can always revert to the previous version
if things go wrong.

This also allows you to try out ideas safely, possibly saving several
different versions of a picture for comparison. Again, you can return
to any version at a later stage, something which is rarely possible with
conventional art media.

To save a picture to disk:

Move the mouse pointer over the word ‘File’ at the top of the
TruePaint screen to reveal the File menu.

Select ‘Save’ from the menu by moving the mouse pointer down
over the menu item and pressing the left mouse button once.

Important: If the picture was originally loaded from disk then
TruePaint will immediately overwrite it with the modified
version. Use Save As instead to give the picture a different
name if you'wish to keep the original!

When saving a picture for the first time (or using Save As) you are
presented with the Save As Options dialog that lets you choose a file
format in which to store the picture.

Choose a suitable format by clicking on its name (the TruePaint
TPI format is usually a good choice when starting off since it was
designed for speed, but use one of the other file formats for
general storage or compatibility with other programs - see
Appendix B for details of the different file formats).

Click on the OK button or press Return. Alternatively, you can just
double-click on a file format.

TruePaint
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Finally, you must decide where the picture file is to be saved and give
it a name. This is done via the file selector, described below. If you
have a hard disk drive then you will probably want to save your
pictures there. When saving to a floppy disk you must ensure that its
write-protect tab is off. Blank floppy disks must previously have been
formatted before use.

It is always a good idea to use the Desktop to create a separate folder
for all your pictures, or possibly several folders, each for different
numbers of colours such as 16 colour, True Colour etc:

When saving, a progress bar may appear. This shows you how much
of the picture has been saved, giving an indication of the time left
before it is complete. Saving is finished once the progress bar reaches
the other side.

The File Selector

TruePaint uses the standard GEM file selector whenever you need to
locate a file on disk. You may install a different file selector by placing
it in your AUTO folder.

Save Image

Directory;

TRAIN

& PALETTES. -
& PATTERNS. -
& TRUECOLR.___
16COL .TIF
16COLOUR. TIF
1_EAGLE .GIF
ARFALL .ART
ARFALL .NED
APLATE .NED

the standard file selector
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Drive

The file selector allows you to choose the name of the file and which
disk and folder it is in. The title at top of the file selector tells you what
action selecting a file will have. You should follow these steps:

Ensure that the correct drive button is selected.
Choose any required folders by clicking on them in the file list.

Type in the picture name, or for loading a picture, click on its
name in the file list.

Select OK to proceed. You can just double-click on a file to select it
and proceed.

At any stage you can click on Cancel to abandon the operation. The
individual parts of the file selector work as follows.

The drive buttons refer to different devices connected to the
computer. Drive A is the internal floppy disk drive, drive B is an
optional external floppy disk. Hard disks are often drive C and RAM
disks, network devices etc. may use other letters.

Simply click on a button to select a drive. The directory will change
and the file list will show you what files are on that drive. If there is a
problem, such as no floppy disk in the drive, the computer will tell you
what is wrong.

Directory

The directory name tells you which drive, folder and files you are
looking at. The drive name comes first followed by “:\". If you are
inside any folders then they will be listed next with a “\" separating
each one: Finally there is a ‘pattern’ which affects what files are
displayed in the file list.

File Patterns

Normally, the pattern will be *.* meaning ‘all files’. Changing this to
* TIF would show only files ending in .TIF. The pattern C*.* would give
the files that started with the letter C. This is useful when searching for
a particular picture or type of file. To change the pattern, click on the
directory name and use the keyboard.

TruePaint
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Selection

This is the name of the file. You can click on this and type a name
from the keyboard but for loading a file it is often quicker to use the
file list.

Note: leaving the three letters after the dot blank when saving
files ensures that TruePaint adds the correct extension for the
type of file. Entering your own file extensions can prevent
TruePaint from recognising the file format when loading.

The File List

This shows the files which match the given pattern and the folders
(indicated by a special symbol) in the currént directory. Use the scroll
bar to move around the list and click on a name. to either select a file
or enter a folder. Double-clicking a file is equivalent to selecting OK.
To leave a folder, click on the close button at the top left corner.
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Background

This section explains various aspects of computer graphics to help you
understand such topics as True Colour mode, outline fonts and Bézier curves,
and how to make the best use of them in your pictures. It assumes no. prior

knowledge

of computer graphics and although suitable for the beginner, is not

essential for learning how to use TruePaint.

The Display

An understanding of how the images displayed on_ your computer screen are
actually formed is a great help when using a computer art package. This first
section discusses the fundamentals of the display.

Pixels

Unlike photographs and paintings, the computer display is in fact
made up of thousands of tiny dots. These little dots are the smallest
objects that the computer can display and it uses them like building
blocks to create all other shapes, forming the graphics and text that
you see on your screen. It is from this property that they get their
name, pixels, which is short for picture elements.

To get an idea of how this works, imagine the screen as a large piece
of graph paper. Each square on the graph paper represents a single
pixel (a good analogy since the pixels are actually arranged in a grid
pattern) which can either be filled or empty.

Now, to draw something like a straight line we could fill in a whole row
of pixels to give a horizontal or vertical line. For a thicker line we could
make it several pixels wide, although it couldn’t be any thinner since
one pixel is the smallest possible display element.

Of course, this wouldn’t be of much use for detailed drawings since
each pixel is far too large and clumsy, but if you made the pixels small
enough (or walked over to the other side of the room) they would
appear to create the illusion of detail. This is essentially how the
computer display works; by making the dots small enough.
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Resolution

OK, so how do we draw a diagonal line? Because the computer is
limited to constructing shapes out of pixels, it has to approximate
diagonal lines and curves as a series of shorter horizontal or vertical
lines placed one after another.

11
a close up of the pixels in a diagohal line

Although this does look something like a-diagonal line, it is by no
means perfect. The pixels become quite obvious as jagged steps in
the line. It is this effect which makes resolufion so important.

Resolution generally refers to the size of the pixels, so a higher
resolution (smaller pixels) means that this effect is less apparent to
the eye. For example, you probably haven’t noticed that the print in
this manual is made up of dots at a resolution of around 1200 per inch!
The word ‘resolution’ is also used to refer to the number of pixels in
the display, usually written as the number of pixels across times the
number of pixels down, €.g. 640x400.

Using a higher resolution is a good way of getting better quality and
sharper images. However, there are trade-offs. More pixels means
more work for the computer, slowing it down and since it has to
remember the appearance of each pixel, more memory.

Overscan

Traditionally, on computer screens that could only show text, a black
border surrounded the actual display area to ensure that parts of the
display didn’t disappear off the edge of the monitor. With the advent
of pixel-based graphic displays this border was retained, but it is
sometimes useful to show pictures that extend beyond it, covering the
entire screen.

This is something that we are quite used to seeing on our television
sets. When it is available on a computer, this effect is known as
overscan. It simply means that there are more pixels than usual so
that they fill the monitor screen. With overscan, you cannot normally
see the edges of the computer display or any surrounding border.
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The Falcon030 supports various overscan resolutions and TruePaint
can use these for viewing and animating pictures. It will also draw
using them if you set up your computer to use overscan by default.
Typically, overscan would be used for video applications, full screen
animation, or just displaying large pictures.

Interlaced Mode

Frames

Another technique used on the Falcon to increase resolution on a
video or TV display is called interlacing. To understand what it does it
is necessary to know a little about the way a monitor or TV works.

The basic idea is that a beam scans across the inside of the screen,
lighting up dots on the display. It starts at the top left corner and
sweeps over the screen, drawing a single horizontal line of the picture.
Once it reaches the right hand edge of the monitor, the beam flies
back to a position slightly below where it started and proceeds to draw
the second line of the display. Each time it does this it lights up
another strip of the image on the phosphor surface inside the screen.

After repeating this many times, a single image frame has been built
up. In fact with the UK television system (PAL) this happens at a rate
of 50 times per second, 60 on an American (NTSC) television.

There are around 300 horizontal scan lines per frame of television,
enough resolution to obtain reasonable picture quality. However, to
improve upon this, the scanning beam would have to generate still
more lines which would mean that it had to travel even faster across
the screen’s surface and adding to the cost of manufacture. This is
where interlaced mode comes in.

The frames themselves are formed in precisely the same way as
before, but instead of starting each frame at exactly the same
position, alternate frames are positioned slightly lower down on the
screen. Half a scan line to be exact. This means that as the beam
scans through the frame, it fills in the gaps between the lines in the
previous frame to give the illusion of twice the resolution without
actually having to do any more work!

TruePaint

Background Page 23



Flicker

Interlacing works extremely well for real life or moving images
because shading and movement help disguise the interlace effect.
However, because computer displays consisting of windows and text
are often static, this effect can become apparent as a visible flickering
of the display.

The flicker is due to the fact that every other frame is slightly offset
from the last. It is most pronounced on single pixel thick lines across
the screen since these don’t even appear in half of the frames due to
the interlacing effect.

Although interlaced flicker can make such modes unusable for
applications such as word processing, the extra resolution is ideal for
most graphics. When running TruePaint in interlaced video modes
you will probably notice much less flicker over the image than in the
window borders.

Colour

Another equally important aspect of computer graphics is, of course, colour.
How we perceive colour, the way the computer handles it, and some methods of
selecting colours in TruePaint are all discussed in this section.

RGB

All colours of light can be split up into colours of the spectrum which
is what a prism does. However, thanks to the way our eyes work, it is
possible to. mix any colour from just three colours: red, green and
blue. This is because there are three sorts of colour receptors inside
our eyes, each sensitive to one of these colours.

These are called the primary colours and are often abbreviated to
RGB. Now if you've always thought that red, yellow and blue were the
three primary colours, this is also correct but for a different way of
mixing colours. Red, green and blue are the primary colours we
actually see, whereas red, yellow and blue are those used when
mixing paint.
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Optical

Mixing

At first it may seem surprising that any colour can be created by
mixing just three colours. To convince yourself of this, try looking at a
colour TV through a magnifying glass. You should be able to see the
tiny dots of red, green and blue which are used to create all of the
colours you see on the screen.

The effect is very similar to that of a picture formed from a mosaic of
individual pixels. Because the spots of primary colour are so tiny, you
do not see them as individual dots at all. Instead, your eyes
themselves mix the colours together, creating the illusion of many
different colours.

Another good example of this can be found in the impressionist
paintings of Georges Seurat in the pointillist style which are
composed of thousands of tiny dots of paint, each carefully placed
and coloured to create the desired form and shade. Upon close
examination you will find that the colours apparent to the eye are
often not present in the painting at all.

Palette Colour

So how do computers display colour? Well, the first problem is the
sheer magnitude of colours which we can see. To display all of them at
once on a computer would require a massive amount of memory. This
is where the idea of a colour palette comes from.

A palette-based display is limited to showing a fixed number of
colours on the screen at any one time, thus saving memory. This can
be as little as two or four different colours or as large as 256. The clever
part is that these colours can be selected from a much greater range,
512 on the Atari ST, 4096 on the STe or over quarter of a million
colours on the Falcon030!

In a 16 colour mode for example, the 16 palette colours would be
carefully chosen to suit the subject matter being displayed. A picture
of an apple might contain several different shades of red (depending
upon the type of apple!) plus perhaps white for highlights with some
greys for a shadow. Choosing a good colour palette is one of the most
important steps in creating palette mode pictures.
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Dithering

As a substitute for having more colours available, we can place
different colours of dots together to produce the effect of a new
colour. This process is known as dithering and is a technique which
you can incorporate into your own pictures.

The simplest form of dithering is to arrange alternate dots of two
different colours in a pattern something like this:

a simple dither pattern

Although we have used black and white here, you would normally use
two similar colours such as light blue and dark blue. On the computer
screen, these would appear to blend together (just like the dots of
paint) giving the impression of a third, intermediate shade of blue.
This would save you having to add an extra blue to your palette,
freeing up a palette entry for a different colour.

Dither patterns with similar colours in a simple pattern usually work
best but more complex patterns with a greater number of colours will
create different effects and textures which can be used to add variety
and realism to your pictures.

True Colour

Although palette modes may be ideal for the computer, the relatively
small number of colours available simultaneously can be limiting. An
alternative approach is for the computer to display as many colours
on the screen as possible.

The human eye can distinguish around 400,000 different colours in
total, although it is sensitive to more of certain colours than others.
However, excellent results can be achieved with far fewer colours
than this. The Atari Falcon030 can display up to 65,536 colours on
screen simultaneously in its True Colour mode (it is worth noting,
though, that Falcon030 palette modes can choose from a much
greater range of colours, but fewer of them can be displayed at once).
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The important thing about True Colour mode is that it has no palette.
Each of the colours can be used in any part of the screen. This has an
important consequence for how we create pictures since there is no
need to worry about which colours to include in the palette; all of the
colours can be used!

True Colour also affords the computer much more flexibility in
dealing with images. Because it can rely on there being a full range of
shades available, it is possible to lighten or darken parts of the picture
easily. Adding a slight tint may also be done without requiring the use
of complex dither patterns. TruePaint gives you full control over such
effects when run in True Colour mode.

The Colour Wheel

Choosing a colour on a computer is often a matter of selecting how
much red, green and blue are to be mixed together as described
earlier. For example, the colour pink is comprised mostly of red with
some blue and green to make it lighter. However, this is not always an
obvious process. How could you create brown for example?
Fortunately, there is a more intuitive method for True Colour work
called the colour wheel.

the colour wheel

The colour wheel is a disc containing all of the ‘bright” colours. It is
arranged with pure colours of the spectrum including the primary
colours around the edge of the disk (see the colour section of this
manual). As you move towards the centre, the colours become paler
so that pastel colours appear in a much smaller circle in the middle
with pure white in the absolute centre.

This is pretty much what you would see if you shone three spotlights,
one for each of the primary colours, onto a white screen so that their
beams overlapped. All three together make white with the secondary
colours (yellow, cyan and magenta) between each primary.
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Picking a colour from the colour wheel is simply a matter of pointing
at it with the mouse and clicking. However, you have probably noticed
that there are a huge number of colours which don’t appear on the
colour wheel at all, such as grey, dark green etc. This is where the
shade bar becomes important.

the shade bar

Whilst moving towards the middle of the colour wheel adds white to a
colour, the shade bar adds black. After picking a colour from the
wheel you can darken it by clicking on the shade bar. Thus greys are
selected as shades of white and dark green appears in the shade bar
when bright green is chosen on the colour wheel.

In fact any colour can be selected by using just these two controls to
first choose a base colour and then the required shade, which is how
you select a colour in True Colour mode with TruePaint.

Detail through Colour

As has already been mentioned, resolution is an important factor in
the quality of computer graphics. It is also true that careful use of
colour can vastly improve the apparent resolution and detail in a
picture.

Again, similar techniques are to be found in conventional art. Great
landscape. paintings such as those by Constable and Turner often
include minute detail formed by just a few or even single
brushstrokes. Yet viewed from a distance these give the impression of
trees, houses or sheep on a hillside.

Perhaps surprisingly, the creation of detail on computers has much in
common with these techniques. If you examine the graphics of most
computer games closely, or in a magazine, especially on small
animated objects you will see that just a few pixels are often used to
represent an eye, arm or leg. It is the clever use of colour which
creates the illusion of fine detail.

Anti-aliasing

Anti-aliasing is the use of colour to disguise the nasty steps in lines
and curves encountered earlier. It involves choosing a number of
colours between that of the object and the colour of the background
and using them to soften the jagged edges.

Page 28 Background TruePaint



an anti-aliased line

Although TruePaint does not anti-alias for you, the effect can be
added manually and is especially useful for small or detailed
graphics.

Fonts

The word font is used to describe a particular style of lettering.
Different fonts have a different appearance; rounded or square
letters, flowing script etc.

Your computer is capable of using many different fonts and styles, all
of which you can incorporate in your pictures with TruePaint. This
section explains the two main types of fonts used by computers along
with their strengths and weaknesses.

Bitmap Fonts

A bitmap is simply a grid of pixels, described earlier. A bit is computer
jargon for a single element which can either be on or off. Because the
computer display consists of pixels, all fonts end up in this form when
they are drawn on the screen. The letter ‘A’ for example would look
something like this:

a bitmapped letter ‘A’

What is significant about a bitmap font is that this is both how the
font was originally designed and how it is stored within the computer.
When writing some text, the computer simply copies the bitmap for
each individual letter into the screen pixels which is nice and fast.
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Bitmap fonts are usually designed by hand so they tend to give the
best results. The person creating the font will have made sure that
each letter is clear and that all the lines are of uniform thickness, even
if the font is very small.

The disadvantage of bitmap fonts is that they are a fixed size. There
must be a separate bitmap not only for each font style but for each
size of lettering too since the arrangement of pixels will obviously be
different. What is required is some way of scaling the font to a larger
or smaller size.

Font Scaling

Any bitmap can be scaled down simply by leaving out rows and
columns of pixels. Halving a bitmap in size for example could be
done by keeping only every second pixel. Although this can be quite
effective for many images since your eye fills in the missing details, it
is not so suitable for bitmap fonts:

The problem occurs when attempting to scale down thin lines. Since
the computer cannot display anything thinner than a single pixel,
what happens is that important details start to disappear completely
when they are scaled down too much. To make matters worse,
increasing the size of a bitmap by doubling up pixels makes lines and
edges look large and blocky.

So, whilst scaling bitmaps can be used to change font sizes and is
certainly useful for resizing graphics, there is a better way of doing
this.

Outline Fonts

The second type of fonts are outline fonts. As the name suggests,
rather than a bitmap of pixels, a description of the outline around
each letter is stored by the computer, making up a complete picture
of what the letter looks like.

a font outline
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To draw the font on screen, the computer has to actually construct
each letter from straight lines and curves, following its stored
description. This process can take a little time so in practice the
bitmap created for each letter is remembered so that it can be quickly
copied from memory next time it is needed. This is called font
caching.

Outline fonts are ideal for scaling since all the computer need do to
create a larger font is draw the font outline at a larger size. Thus any
font size can be created without blocky pixel effects or missing lines
since everything gets drawn again in the correct resolution.

Although outline font scaling is not built into the Atari ST or Falcon, it
is available in the form of the Speedo GDOS software package. More
information concerning this can be found in Appendix C.

The Best of Both Worlds

Why bother with bitmap fonts at all? The answer is that since they are
designed by hand they are more readable, especially at small sizes. It
is very difficult for the computer font scaler to adjust each letter so
that it ‘looks right’ but this is exactly what human font designers can
do.

So in practice it is usually better to use a combination of bitmap and
outline fonts. Outline fonts for flexibility and high quality lettering at
large sizes, bitmaps for small text and specific, commonly used font
sizes.

Bézier Curves

Both computers and rulers make drawing perfect straight lines very
easy but curves are often more important in real images. Instead of
using trial and error to obtain the desired results, TruePaint gives you
the ability to produce perfectly smooth curves in a simple and
predictable manner.

These curves are called Bézier curves (pronounced ‘bey-zee-ay’) after
the French engineer who invented them for use in designing Renault
cars. They are also the type of curves used by the font scaler to form
text.
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Control Points

In addition to having a start and an end point, Bézier curves have two
additional control points whose position determines the shape of the
curve. Although the curve does not actually pass through these points
they act like magnets, each of them bending the curve between the
fixed start and end points.

some Bézier curves and control points

When drawing such curves it may help to think of them as the path
followed by a moving object. From the start point it begins to travel in
the direction of the first control point. But as it moves it is gradually
drawn towards the second control point. Midway between these two
points it decides to head for the end point and in doing so has traced
out the shape of the curve.

Alternatively, picture the curve as being constructed from a series of
straight lines. The first three lines simply connect the four points.
Then the midpoint of each line is joined together. Once this process is
repeated a few times the shape of the curve becomes apparent.
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a Bézier curve as straight lines

Of course the best way to learn about Bézier curves is to use the
computer to experiment. TruePaint allows you to adjust the position
of each point any number of times before actually drawing the curve
on the picture. You can make use of this facility to find out how each
point affects the overall shape of the line.

Joining Curves

Although single Bézier curves come in a variety of shapes including S-
curves and loops, you will often want to place two or more curves end
to end to produce more complex outlines. Ideally, the second curve
should flow smoothly on from the first without any sharp corners at
the join.

poorly joined Bézier curves

There is a trick to this. When you start the second curve from the end
of the first, imagine a straight line extending from this point in the
same direction as the end of the curve. Placing the first control point
somewhere along this line will ensure that a smooth curve is
produced.
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[c} @ ©
continuous Bézier curves

What you are actually doing is making sure that the join and the two
adjacent control points all lie in a straight line (indicated by the
dotted line on the diagram) which, due to the way Bézier curves work,
always guarantees perfect continuity.
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Tutorials

There are eight tutorials in all, each one covering a different (aspect of
TruePaint. They may be read in sequence or you can turn to a specific tutorial
for a step by step guide to a particular feature. Don’t be afraid to experiment
with the described techniques by creating pictures as you go along!

More detailed information concerning each option, drawing. tool and menu
item can be found in the Reference section if required.

1: Drawing with the Mouse

The first step in learning to use a paint package is becoming accustomed to
using the mouse as a drawing tool. This first tutorial also introduces you to some
of the basics of TruePaint.

Starting a Picture

After running the TruePaint program as described in Gefting Started,
a blank screen will appear with a menu bar at the top. Before you can
start drawing you need to create a new image in a window as follows:

. Move the mouse pointer up to the word ‘File’ at the top of the
screen to reveal the File menu then down over the word ‘New’ so
that it lights up. Now press the left mouse button once.

. A small window saying New Image will appear. Move the pointer
over the Screen button and click once. This will open up a window
containing a full screen sized image ready for drawing,.

You aren’t just limited to one window. If you want several images you
can repeat this process to create as many windows as you like,
memory permitting, up to the maximum allowed by the operating
system. See Getting Started for details of how to use the various
window controls.
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E‘ Freehand Drawing

TruePaint starts up with the Pen tool active so that you can start
drawing straight away. The icon representing the Pen tool (below the
spanner icon on the left of the window) will be lit up to indicate this.

Drawing takes place in the drawing area which is the large empty box
taking up most of the window. This area shows part of your picture. To
start drawing, do the following:

Move the mouse pointer over the drawing area so that the pointer
changes from an arrow into a crosshair.

Hold down the left mouse button and move the mouse around the
drawing area.

Release the mouse button to stop drawing.

Each time you move the mouse with the button held down, a
continuous trail of colour will be left behind. The Pen tool essentially
turns the mouse pointer into a pen which draws when the button is
down and is lifted from the paper when the mouse button is released.

How to Undo Mistakes

Of course, everybody makes mistakes and one of the nicer qualities of
computers is that they (usually) allow these to be corrected or undone
without having to start all over again.

TruePaint allows you to undo any changes to the picture and even to
put them back again if you change your mind. To undo the most
recent changes you should:

Move the mouse pointer over the word ‘Edit" at the top of the
screen to reveal the Edit menu.

Move down over Undo so that it becomes highlighted and press
the left mouse button once.

Alternatively, you can just press the Undo key on the keyboard.
Choosing Undo is always safe because you can Undo a second time to
restore the image. If TruePaint tells you it cannot Undo (after loading
a picture for example), just press Return.

Important: The way that Undo works is by remembering all
the changes you made since you last moved off the drawing
area. Because of this, Undo can correct several changes at
once or just one.
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For example, if you draw three lines without moving off the
drawing area and select Undo, all the lines will disappear. But
if you moved the pointer outside this area after the first line
was drawn then only two will disappear.

Clearing the Image

If you decide that you have made a complete mess of the picture, you
can clear it and start again in the following way:

Move up to the Edit menu and select Delete by clicking on it.

Answer OK to the alert box which appears by moving the pointer
over the OK button and pressing the left mouse button once.

If you select this by accident then you can'always click on Cancel or
use Undo.

It is a good idea at this stage to practice some freehand drawing with
the mouse before continuing. You could start with some simple
sketches of faces, cars, animals, cartoon characters etc. to gain
familiarity with the mouse. Try signing your name - it isn’t as easy as it
sounds! Use Undo if necessary and Delete or New whenever you want
to start a new drawing.
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start with something simple
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Drawing. Dots

For some variety, try clicking once on the Dots tool (underneath the
triangle icon). You can draw with it in a similar way to the Pen tool
except that it leaves a series of dots instead of a continuous line. If you
move the mouse quickly then the dots will be more widely spaced.

To return to the Pen tool, click on its icon so that it becomes
highlighted as before.

Full Screen Mode

Finally, you may find Full Screen mode uséful. Normally, each
drawing is contained within a window as described in Getting Started
but in Full Screen mode the window borders and menu display
disappear and the entire screen becomes your drawing area.

Select Full Screen on the View menu or press the Clr Home key to
enter Full Screen mode. You can continue drawing as usual but with
the whole screen. Use the cursor keys to move around the picture or
click and drag with the Alternate key held down so that the pointer
turns to a hand (this works even in window mode). Press Clr Home
once more or Esc to leave Full Screen mode and return to the normal
window display.

All of the TruePaint drawing tools work in Full Screen mode so you
may wish to use it during any of the other tutorials. Although the
toolbox, menus or dialogs are not available, many of the keyboard
shortcuts listed in Appendix A may still be used.
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2: Drawing Shapes

This tutorial explains how to use the drawing tools for creating lines, circles,
rectangles and other shapes. It assumes that you are familiar with using
TruePaint’s window display and the mouse.

"~ | Straight Lines

You will often want to use straight lines in your pictures and these can
be drawn using the Line tool. To draw a straight line:

Select the Line tool by clicking on its icon (next to the Pen tool).

Move over the drawing area and position.the mouse pointer where
you want the line to start.

Holding the left mouse button down, move the pointer to the end
point of the line and release the button to draw it.

While you are doing this you will notice that a ‘rubber band” line
follows the mouse around. This is to remind you where the line starts
and finishes so that you can position it accurately before actually
drawing the line.

E‘? H—| Connected Lines and Rays

A slight variation on the above, these produce a series of straight lines
either connected to one another or converging on a single point. They
both work in a similar fashion:

Select the Connected Lines or Rays tool by clicking on the
appropriate icon.

Move the pointer over the drawing area and press and release the
left button once to start the lines off.

Now all you need do is click once for the end point of each line.
Since they automatically connect to the previous one, you should
not hold the button down while moving the mouse; just press and
release.

Click on the tool icon once more to start a new series of lines, or
select another drawing tool to finish.
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To recap: the Line tool is for individual straight lines, Connected Lines
for a series of continuous lines and Rays for lines originating from the
same point.

Perspective Drawing

The Rays tool is particularly effective for giving the effect of
perspective in your drawings. To the eye, parallel lines receding into
the distance appear to converge on a vanishing point somewhere
along the horizon. In practice, several vanishing points are often
apparent, each in a different direction.

using the Rays tool for perspective

To mimic this effect we can select the vanishing point as a starting
point for the Rays tool. If you draw some lines corresponding to the
edges of a road or a terrace of houses going off into the distance then
this framework can be used as the basis for a picture.

Line Thickness

Up to this point we have used just one thickness of line but TruePaint
allows you to choose the line thickness for most of the tools we have
encountered so far. To adjust the line thickness you should:

Double-click (press the left mouse button twice in succession) on
one of the line drawing tools or the Pen tool. This will reveal a
window called the Line Attributes dialog.

The vertical line at the right of the dialog shows the currently
selected thickness. To change this, move the mouse pointer over
one of the buttons marked ‘+’ or " and hold down the left mouse
button.

Click on the OK button to accept the changes.
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You can change the line thickness in this way to suit each different
part of your picture. See if you can create a realistic looking tree using
the various drawing tools and line thicknesses (hint: you can use Rays
for branches).

& |B | i cles and Rectangles

Circles, ellipses (ovals) and rectangles are drawn in much the same
way as straight lines by simply stretching out a shape of the required
size. For example, to draw a circle:

. Click on the Circle icon (the completely filled one).

. Position the mouse pointer in the drawing area where you want the
centre of the circle.

. Hold down the left mouse button and move the mouse diagonally
up and to the right. A circle will appear, changing shape and size
according to the position of the mouse pointer.

. Once you are happy with the shape, release the mouse button to
draw it.

You will notice that although an outline was visible when moving the
mouse, a solid shape was actually drawn. This is because Filled
Shapes on the Options.menu is on, indicated by a tick in the menu.
Selecting it will switch this off so that outline shapes can be drawn. To
switch it back on, select it again.

Square and rectangular boxes are drawn in much the same way with
the Rectangle tool. Position the pointer over one corner of the box,
hold down the mouse button and drag to the opposite corner,
releasing the button to draw the shape.

A Polygons

Polygons are simply multi-sided shapes which includes squares,
triangles, hexagons etc. These can all be drawn with the Polygon tool,
represented by a triangle icon. Using this tool is much like drawing
connected lines; you click once for each corner of the shape. Try
drawing some triangles to see how this works.

For shapes other than triangles:

. Double-click on the triangle icon for the Polygon Attributes dialog.
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Press the Backspace key twice and type in a number of sides from
the keyboard, 5 for example.

Press the Return key or click on the OK button.

Drawing the shape is done exactly as before except that you select a
different number of points, five in our example would draw a
pentagon (or star). The shape will be filled if Filled Shapes is selected.

If you also select the Regular box then you can draw polygons with
equal length sides in the same way as circles, by dragging out a shape.
See the Reference section for details.

Free Form Shapes

Free Form in the Options menu is also selected by default so that
‘non-square’ shapes such as ellipses and rectangles can be drawn.
You can switch this off to allow only exact circles, squares and regular
shapes if you want.

Using the tools already described you should be able to draw much
neater and more detailed pictures than you could using just the
freehand Pen tool. Try some drawings that make use of these tools, a
simple drawing of your house for example. You may want to save
some of these to disk for working with in later tutorials.

Selecting Patterns

In addition to single colour filled shapes you can have patterns too.
Clicking on the checkerboard icon at the top of the toolbox presents
you with a choice of patterns you can select by clicking on them. The
current pattern is shown at the bottom of the toolbox. Select the single
colour pattern for solid filled shapes as before.

To return to the normal toolbox display, click on the Drawing Tools
(spanner) icon. It is also possible to define your own fill patterns from
this display, see the Reference section for details.

Filling an Area

Another method of filling shapes is to use the Fill tool. With this tool
active, clicking on the drawing area will fill outwards from that point
with the selected colour and pattern. This can be used to fill in an
irregularly shaped area or change a shape’s colour.

Note that the area being filled must be completely enclosed by
another colour otherwise the fill will ‘leak’ out over the rest of the
picture. Don’t panic if this happens, use Undo.
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3: Colour

This tutorial describes the use of colour within TruePaint. It explains how to
choose a drawing colour, select a palette and how the various colour effects such
as Rainbow mode work.

Choosing a Drawing Colour

If you have read ahead or are just inquisitive then you may already
have discovered how to change the drawing colour, in which case you
might want to skip this part. Otherwise, to choose the pen colour you
should:

. Select the Palette icon at the top of the toolbox. Either a series of
coloured boxes or a colour wheel and shade bar will appear
depending upon the screen mode (see the Background section).

. Clicking on a coloured box with the left mouse button will select a
colour. Otherwise, click first on the colour wheel (you may drag the
mouse with the button held down if you wish) and then on the
shade bar if a darker colour is required. You can also click outside
the colour wheel to select pure white.

. Once the desired colour is shown at the bottom of the toolbox you
can click on the Drawing Tools icon to return to the normal
display.

If you return to the drawing tools display, the chosen colour will be
shown in the Pen Colour indicator beneath the tools. However, you
can continue drawing with the previously selected tool from within the
Palette display.

It is often easier to first select the drawing tool you wish to use and
then switch to the Palette display for drawing and choosing colours.
That way, you only have to leave the Palette display to select a
different tool. You can do tricks like drawing different coloured rays
by choosing a new colour before drawing each line.

Picking a Colour from the Image

You will often want to draw in a colour which exactly matches an
existing part of the picture. To save you resorting to trial and error
there is a special tool for this, used as follows:

. Select the Pick Colour tool by clicking on its icon at the bottom left
of the drawing tools.
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Position the mouse pointer over the area of colour which you want
to match and hold down the left mouse button.

If the Pen Colour indicator doesn’t show the desired colour then
you can move the mouse around to find the right colour before
releasing the button.

Changing the Palette

As described in the Background section, a palette is the selection of
colours that appear on the screen. Each TruePaint window has its own
palette which you can change to suit the image. Note that this is not
necessary in True Colour mode since it has no palette!

Assuming that you are running in a palette mode (16 colours for
example), here is how to change the palette:

Move the mouse pointer up to. the Options menu and click on
Colour to produce the Colour Options dialog (alternatively you
can double-click on a palette colour or the Pen Colour indicator).

Select a colour to change by clicking on it. Be careful when
changing the first two colours since they are also used for the
window display.

Use the Red, Green and Blue sliders to mix the desired colour
from primary colours. You can click on the slider background or
arrows to change its value, or click and drag the slider itself.

After repeating the previous two steps for each colour that you
wish to change, select OK to continue.

You can click on Restore at any time if you change your mind about
your new colour scheme. Note that when you change a palette colour,
parts of the picture drawn in the old colour will also change to the new
colour.

Try adding orange to your palette (orange is made up of red with
some green and no blue) and experiment with the three sliders to get
used to mixing colours. To help you along, here are some hints:

Red and green make yellow, red and blue make purple, green and
blue make turquoise, and all three together make white.

To make a colour darker, move all the sliders down.

For a paler colour, add white by moving each of the sliders
upwards.
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Choosing a Palette

To get the most out of palette modes it is very important to choose a
good palette for your picture. There is no ideal palette for all pictures,
instead each picture will need a different palette depending upon the
subject matter. Since there are a limited number of colours, it pays to
choose carefully.

First decide what the main colours will be. If you are drawing a car, the
main colour might be red with black for the background. Having
more of these colours in your palette will allow you to add realistic
shading effects or you can use dither patterns as described in the
Background section to give the impression of even more shades.

Now work out which other colours will be required. This might include
highlights, shadows, foreground and background detail and text if
required. Using only one of each colour where possible will maximise
the number of palette entries available for the main colours.

In this way you can build up a palette on the basis of how important
each colour is and how much it is used in the picture to make the best
use of the available colours.

Write Modes

The Write Mode affects how what you draw is combined with the
background. Normally the background is simply overwritten and
patterns are drawn in a combination of the pen colour and the default
background colour. You can change this in the following way:

Select General on the Options menu to reveal the General
Options dialog.

The Write Mode appears at the top left of this dialog. Click on the
box next to Transparent to select it.

Click on the OK button to continue.

If you try selecting a pattern and drawing a filled shape now you will
see that the original picture shows through the gaps in the pattern.
You can return to the normal behaviour by selecting Replace. The
other Write Modes are mainly used for special paste and text effects.

TruePaint

Tutorials Page 45



Rainbow Effects

One unique feature of TruePaint is the ability to draw ‘rainbow’ lines
and shapes. Instead of using the current pen colour, everything will
be drawn in a number of sections to give a multicoloured effect. This
works best in True Colour mode.

You can switch Rainbow mode on and off by selecting Rainbow on the
Options menu. Try drawing some lines and filled shapes to see how it
works. To change the start and end colours of the rainbow you can:

Select Colour from the Options menu or double-click the Pen
Colour indicator to reveal the Colour Options dialog.

Click inside the box next to Rainbow 1 or. Rainbow 2 to choose the
start or end colour.

Choose the desired colour in the normal way from the colour
wheel, sliders or palette.

Once you have chosen both colours, click on OK.

When you change either Rainbow colour you will see the sample
Rainbow in Colour Options change. In palette-based modes, the
Rainbow will consist of the palette colours from Rainbow 1 and
Rainbow 2 in order. True Colour mode however always gives you a
smooth graduation between the two colours.

Note that with the Rainbow 1 or Rainbow 2 box selected, the Pick
Colour tool will change the appropriate rainbow colour in addition to
the pen colour. You can also draw Rainbow lines with the Pen tool.

Shadows

Shadow is another special effect for use with lines and shapes. It gives
the impression that the shapes are hovering some distance above the
background, casting a shadow on it. To enable this effect:

Select Shadow on the Options menu to get the Shadow Options
dialog box.

There are 9 boxes at the right of the dialog representing different
shadow directions. Try selecting the lower right one to begin with.

Click on the OK button.

Now try drawing with the Pen tool. To switch the effect off again, follow
the same procedure except click on the centre box for no shadow.
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4: Brush Effects

This tutorial describes how to use the various TruePaint brush effects including
Airbrush, Smooth and Tint. Note that some of these effects are only available in
True Colour mode.

) Airbrushing

The airbrush effect may be used in both palette and True Colour
modes and gives the effect of paint sprayed onto the picture. This
produces a random, textured appearance instead of solid areas of
colour. To use the airbrush:

. Click on the Airbrush tool icon.

. Position the mouse pointer where you want to start spraying in the
drawing area.

. Hold down the left mouse button and move the mouse to spray
rapidly to give a light spray effect or more slowly for a dense spray.

You can build up colour by repeated spraying of the same region or
by moving the mouse in small circular motions. Fine control over the
airbrush effect is available via the Airbrush Attributes dialog. For
example, to increase the size of the airbrush:

. Double-click the Airbrush tool to reveal the dialog box.

. Increase the nozzle size by clicking on the up arrow button. You
will see thecircle on the left changing in size. This represents the
area around the mouse that will be affected.

. Click on the OK button.

You may also change the quantity of colour which is sprayed by
clicking in one of the Flow Rate boxes. For more colourful effects, try
using the Airbrush tool in Rainbow mode.
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Smoothing

Tint

The smoothing effect only works in True Colour. It is used to blend or
blur parts of the picture to give a ‘watery’ appearance. You might want
to use it after adding a highlight or shadow to soften the sharp edges
where the new colour meets the old. It is used as follows:

Select the Brush tool by clicking on its icon in the toolbox.

Position the mouse pointer over the area to smooth. A rectangular
box should appear, showing you the region over which the effect
will be applied.

Hold down the left mouse button and move the pointer as
necessary. Keep moving the mouse until the desired effect is
achieved.

Try using this to create the effect of waves upon water. Select a
reasonable line thickness and choose light blue from the Palette
display. Using the Pen tool, draw broad horizontal strokes of colour
onto the image to look like waves (you don’t need to be very careful).

Once you have done this over the whole window area, repeat the
process using a different shade of blue. The idea is that the old lines
show through the gaps. Keep adding different shades until you have
built up a pattern that covers most of the white background. You
might also want to ‘add a few lines in a much lighter colour for
highlights.

The final step is to use the Brush tool over the whole image to smooth
it out, giving the water effect. You can even repeat the whole process
again to add more colour and depth to the texture.

Another True Colour brush effect is Tint. It can be used like the
Airbrush tool to spray colour over the image except that it blends the
pen colour into the background instead of drawing scattered pixels of
colour. To select Tint:

Call up the Brush Attributes dialog by double-clicking the Brush
tool icon.

Click in the Tint box to select it.

Click on the OK button.
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Using the Brush tool as before will now add colour to the rectangular
brush area. You might want to experiment with some of the other
Brush Modes such as Smooth Tint, Lighten and Darken.

Applying Effects to an Area

Until now we have used a rectangular brush shape but there are
others. Like the airbrush, the brush size may be varied and a circular
brush shape is available. It is also possible to apply a brush effect over
a large area of the picture in the following way:

Select the Area box on the Brush Attributes dialog and click OK.
Position the mouse pointer over one corner of the area.

Hold down the left mouse button and move the mouse to stretch
out a box of the required size (just like using the Rectangle tool).

Release the mouse button to apply the effect. Depending upon
the size of the area, this may take some time.

The Rainbow 1 Range

The remainder of the brush modes are used for colour changing. This
includes re-colouring part of a picture, replacing one colour with
another and swapping palette colours around.

Brush modes mentioning Range adjust only certain colours, leaving
others alone. They use the Rainbow 1 colour selected in Colour
Options and Rainbow 1 Range in Brush Attributes. The way that this
works is that colours close to the Rainbow 1 colour are considered to
be within the range and are changed by the brush effect.

Changing Colours

For example, try the following to re-colour an object in an existing
True Colour picture:

Choose the Circle brush shape and Replace Range mode from the
Brush Attributes dialog.

Select the Rainbow 1 box on the Colour Options dialog and use the
Pick Colour tool to select the main colour of the object you wish to
change (this will also select Rainbow 1).

Use the Palette display to choose a new colour.
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With the Brush tool, draw over the object as if using the Tint brush
mode to ‘colour it in".

Only those colours close to the Rainbow 1 colour you chose should be
affected, allowing you to effectively re-colour the object. If other
colours are also changed, use Undo and try entering a smaller
Rainbow 1 Range.

A range of one will include only the Rainbow colour itself which can
be used to selectively erase a temporary grid or layout lines drawn
onto the picture.

Swapping Palette Colours

In order to swap between two palette colours you must use the Swap
Ranges mode with an Area brush and a Rainbow 1 Range of one.
Select the pen and Rainbow 1 colour as before for the two colours to
swap and drag out a box covering the area to affect. You can use Full
Screen mode to select the entire picture.
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'5: Cut and Paste

The term ‘cut and paste’ refers to the technique of copying from one image into
another to duplicate part of a drawing or as a way of assembling a picture or
animation from many parts. This tutorial explains how this is done and how to
achieve the best results.

i----!| Selecting an Area

Before you can copy part of an image you must first select it in the

following way:
. Click on the Selection tool at the lower right of the toolbox display.
. Position the mouse pointer over the image and holding down the

left mouse button, drag out a rectangle.

. When you let go of the mouse button, a rectangle with small
square ‘handles’ at each corner will appear. These may be used to
adjust the size of the area by positioning the mouse pointer inside
them, holding down the mouse button and dragging.

. The entire area may be moved by clicking inside the rectangle
and dragging.

Try selecting and adjusting different areas to get used to how this
works. Note that clicking outside the selected area will deselect it
again. There is also a command on the Edit menu called Select
Visible which quickly selects the entire visible area of the image.

Selecting an area in this way has another use. If you switch back to
one of the drawing tools such as the Pen tool, you will find that it now
only draws within the selection. Mouse presses outside the selected
area are ignored. This is useful for changing one small area without
disturbing the rest of an image.

The Clipboard

The cut and paste technique makes use of a clipboard. This is where
the piece of the image previously ‘cut’ is kept, ready for pasting
somewhere else. In a sense, the clipboard is like a hidden extra
window which remembers whatever was last put into it.
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The clipboard only has space for a single image, so whenever you cut
or copy something into it the previous clipping is lost. Quitting
TruePaint will also lose the contents of the clipboard although pasting
does not, so you can paste a single clipping any number of times.

Cut, Copy and Paste

The three commands that use the clipboard are Cut, Copy.and Paste
all of which can be found on the Edit menu. For an example of how
they can be used to transfer part of an image from one window to
another, try the following:

Select the area that you wish to copy using the method described
above.

Select the Copy command from the Edit menu. This stores the
selection in the clipboard. You could use Cut instead which would
also erase the selected area.

Activate the destination window in the normal way.

Select Paste from the Edit menu. This will cause the clipboard
contents to appear inside the window ‘floating” over the image.
You can position it by helding down the mouse button over the
selection and dragging it to a new location.

Finally, double-click the left mouse button to actually draw the
clipping onto.the image. Be careful not to move the mouse
between clicks. Clicking outside the selection will cancel pasting.

You can use this process to copy between any pictures or even
duplicate part of an image elsewhere on the same image. Using Cut
instead of Copy can be used to move sections from one place to
another.

One thing to watch out for when pasting palette-based images is that,
since each picture can have a different palette, the pasted section
may appear in the wrong colours. You can get around this either by
using the same (or similar) palettes for each picture or by changing
colours with the Brush tool after pasting.
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Transparency

How to

Cutting

Cutting and pasting rectangular sections is all very well but you will
often want to paste an irregularly shaped object onto a background.
This can also be done if you change the Write Mode to Transparent.
The Write Mode is accessed through General on the Options menu
as described in the Colour tutorial.

Try drawing some different coloured triangles and using select, Copy
and Paste as normal. With Transparent mode, areas of the default
background colour become transparent when pasted so that the
underlying image shows through, making it look like the object was
drawn there originally.

Note: in True Colour mode, only pure white will be
transparent when pasted. Always click on the white
background outside the colour wheel to select this colour for
drawing.

Avoid Holes

There are three main problems with transparent pastes. The first is
that only the first palette colour (or pure white in True Colour mode)
can be used as a background when drawing the image for
Transparent to work. Another problem is that if this colour is used
elsewhere in the image-it will also become transparent, producing an
unwanted ‘hole’ when the image is pasted.

Both of these difficulties can be solved by drawing the image on a
different colour background and then using the Fill tool to change the
surrounding area to the transparent colour before pasting. This
makes it easier to ensure that the transparent colour is not itself used
in the picture. You can also fill areas of the background colour as
required after pasting.

Out Complex Shapes

Since the Selection tool only deals with rectangles, the third problem
is in cutting out a complex shape from an existing image. The best
way of doing this is to first copy the region containing the object into a
separate window and then cut away the remaining background areas.
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By selecting the transparent colour for drawing (see the previous
note) and using the Pen tool with a reasonable line thickness, start
chipping away at the rectangular block. Imagine that you are
sculpting a block of stone or wood; start by eliminating any large
unwanted chunks, taking more care over the detailed edges of the
object using thinner lines and other drawing tools as necessary.

Once this is complete (and it does take a little patience!) you have a
copy of the image on a background of the transparent colour which
can be copied and pasted onto another image as before.

Assembling a Picture

It is sometimes useful to create each different part of your picture as
a separate image to be pasted together later. Some of the advantages
of this are:

Better control over where everything goes.

You can erase part of the image without having to re-draw the
background underneath it.

Changing the background itself is much easier.
It is easy to create and compare different versions of the picture.
You can even use the same component images in several pictures.

Since many of these factors become even more important when
dealing with animations, here are a few tips to bear in mind when
assemblinga picture in this way:

Save your work regularly!

For transparency, either draw on the default background colour or
use the fill technique described earlier.

Ensure that you use the same palette for each picture (not
applicable in True Colour mode).

Check that everything is drawn to the same scale so that parts of
the final picture don’t appear out of proportion.
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6: Effects

This tutorial explains how the various image transformations on the Effects
menu work and what they are for. It also describes how to produce mirrored and
symmetrical drawing effects.

Flip

The simplest effects on the Effects menu are H-Flip and V-Flip since,
unlike the others, they can be used without selecting an area to
‘mirror’ the entire picture. H-Flip gives a normal mirror image
whereas V-Flip turns the picture upside down. Selecting the same
effect again will restore the picture. Use both effects together to rotate
the image through 180 degrees.

Note that these effects work on the whole image, not just the visible
portion so you may find yourself looking at the opposite side of the
picture. To flip part of an image, select it as described in the previous
tutorial before using H-Flip or V-Flip.

Resize and Stretch

Both of these effects alter the size of the current selection. You can
use them in the following way:

Select an area with the Selection tool or Select Visible menu item.

Choose Resize or Stretch from the Effects menu. Note that the
menu shows a tick next to the command to remind you of what
you chose.

Use the handles at each corner of the selection to adjust the
image size by clicking and dragging with the mouse. They work in
exactly the same way as the handles used for selecting an area
except that they actually resize the image.

Reposition the image by holding down the mouse button inside
the selected area and dragging it to a new location as if pasting.
You can resize and drag as many times as you want.

Double-click over the drawing area to paste the resized image
onto the background.

As you can see, this process is very similar to using Cut and Paste and
can in fact be used in conjunction with them.
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The difference between Stretch and Resize is that the latter always
preserves the proportions of the image, unlike Stretch where you can
distort the selection by making it wider or taller.

Combining Effects

Pattern

Many of these effects may be used in combination with each other
and they all work with Paste. This means that you can carry out
several effects one after another before finally committing the results
to the image. For example:

Select and Copy an area.
Select Paste from the Edit menu.

Choose V-Flip from the Effects menu. Notice that the selection
has been altered even though it has not yet been pasted onto the
background.

Now select Stretch from the Effects menu. The results of the
previous effect can now be resized.

Finally, double-click to draw the selection on the image or click on
the background to cancel.

This effect works very much like Stretch except that instead of
resizing the selection it ‘“tiles’ it to give a repeating pattern. You can
use this to create various textures or to save time when pasting
several copies of the same image.

Try selecting a small area of a picture and creating a pattern from it.
Alternatively, reduce a large image in size before using Pattern. Note
that you must make the selection larger to get the patterned effect.

Shear and Wrinkle

The final four effects distort the actual shape of the selection. Shear
skews the image as if it were on a slope and Wrinkle bends it
backwards and forwards to give a rippled or folded effect. Once again,
you simply position the handles to achieve the desired results.
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To wrinkle an image you would do the following:
Select an area or start pasting.

Move up to the Effects menu and click on H-Wrinkle. An
envelope shaped box should appear.

Click and drag the two handles to create the required degree of
wrinkling (the ‘flap’ of the envelope represents a single fold or
wrinkle; its height is the length of the fold which will be repeated
down the entire image and the distance from the box determines
the width of each fold).

Double-click to draw the results onto the image.

Mirrored Drawing

This final special effect does not appear on the Effects menu since it
does not operate on the selected area. The Mirror options actually
repeat everything you draw by reflecting it as if through a mirror. This
results in a perfectly symmetrical design and can be used to generate
kaleidoscopic patterns and shapes. To switch mirroring on:

Select General from the Options menu.
Click inside the box marked 4- Way under the Mirror options.
Click on the OK button.

Now try drawing something with the Pen tool. You will find that your
drawing is reflected in each quarter of the image. Note that drawing is
still limited to the visible or selected area however.

In fact, mirroring actually happens through a point called the origin
which can also be changed from the General Options dialog. By using
the other Mirror options you can also adjust how drawing is mirrored.
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7: Adding Text

This tutorial covers the use of TruePaint’s text drawing facilities and how to
produce textured and coloured text. A discussion of how text and fonts work can
be found in the Background section.

g N

Drawing Text

Adding text to a picture is quite simple and involves the following
steps:

Select the Text tool by clicking on its icon in the toolbox (it's a
letter T").

Move the mouse pointer over the drawing area roughly where you
want the text to start (dont worry too much about the exact
positioning at this stage).

Type the text in from the keyboard. You can use Backspace to rub
out mistakes. '

If necessary, you can.reposition the text by clicking the mouse
over the drawing area. Note that you may continue typing after
this if you wish.

Finally, double-click the left mouse button to draw the text on the
picture.

If you are using TruePaint for drawing labelled diagrams or charts
then you may wish to use the Line Attributes dialog and Line drawing
tool to draw lines with arrowheads on the image.

Note: none of the keyboard shortcuts are available while the
text tool is active.

Choosing a Font

The font is the style, size and shape of lettering used for text. The
particular selection of fonts available on your computer depends
upon what is installed and whether Speedo or Font GDOS is running
(see Appendix C). To select the font:

Double-click on the Text tool to produce the Text Attributes dialog
box.
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Choose a font by clicking on its name in the list at the top of the
dialog. The two arrow buttons at the side may be used to move
through the list.

Adjust the font size by holding the left mouse button down over
any of the group of four arrows. Alternatively you can click on
width or height and use the keyboard to enter a new size, pressing
Return when finished. Note that the width and height are
normally the same.

Select any desired text effects such as bold, italic, etc. by clicking
on the relevant box so that it lights up. You can switch effects off in
the same way.

Click on the OK button.

If you now draw some text you will find that the new font size and
styles are used. You can use this procedure to change any or all
aspects of the font as required.

Normal /a/e

Bold ' Underline
Light « Outline

various text effects

Transparency

Like most drawing, text is affected by the Write Mode in General
Options. The default Write Mode (Replace) draws text in the pen
colour on a solid background. You may already have noticed the white
box drawn under the text.

Changing the Write Mode to Transparent as described in the Colour
tutorial allows text to be superimposed upon any background.
Although the letters still appear in the pen colour, no white box is
drawn so that the picture shows through the gaps between the letters.

Transparent mode is generally better for text and looks nicer than the
default, although you should take care to choose a pen colour that is
readable against the background.
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Multicoloured and Textured Text

Cutting

Another Write Mode which is useful for text is Stencil. It is the exact
opposite of Transparent and has the effect of drawing only the text
background, leaving the text itself transparent like a stencil with the
picture showing through each letter. This is how multicoloured and
textured text are achieved.

Firstly, create the pattern for the text over a sufficiently large area in
as many colours as you like using the normal drawing toels: You could
use the water texture described in the Brush Effects tutorial. Then
simply draw the text over this background in Stencil mode, a large
font size usually works best. You can trim off any excess pattern
afterwards.

Although this technique works well for bitmap fonts, it is less suitable
for outline fonts since these often give gaps between each letter.
Instead of manually erasing each of these gaps you can use cut and
paste to achieve the same effect.

and Pasting Text

The simplest use of cut and paste with text is to Copy a piece of text
into the clipboard and Paste it several times to save typing or for a
shadow effect. Another idea is to select some text and use the Effects
menu to alter it to give reflected or skewed text. See the previous two
tutorials for details.

However, if you want to use the Stencil effect with outline fonts, or
indeed any shapes other than text, here is what you should do:

Draw the pattern or texture as before but in a separate window.

Elsewhere in this window (or another window again), draw the text
in Replace mode. Do not use Stencil mode at this stage.

Using the Selection tool, select the text and Copy it into the
clipboard (see the Cut and Paste tutorial).

Now change the Write Mode to Stencil using the General Options
dialog box.

Choose Paste from the Edit menu and position the text over the
pattern. When you double-click, the stencil effect will be applied,
giving you patterned text.

Finally, Copy and Paste this text into the picture as necessary
(don’t forget to change the Write Mode back to Replace first
though!).
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8: Detailed Work

This final
editing of

tutorial describes those TruePaint features which assist with detailed
the image and accurate mouse positioning.

The Hot Spot

The TruePaint Hot Spot is a magnified display of the area
surrounding the mouse position which can be positioned either above
or to the left of the drawing area. To switch the Hot Spot display on:

Select General from the Options menu.

Click on the Hot Spot box marked either Top or Side depending
upon where you want the display to appear.

Click on the OK button.

The magnified area automatically tracks the mouse as you move it
around the drawing area. The small square fixed in the centre of the
Hot Spot display represents the actual mouse position. To turn it off
again, follow the same procedure but click in the box marked Off.

The advantage of the Hot Spot is that you can still use all of the
regular drawing tools but with much greater precision due to the
magpnification. You could use it to ensure that two lines meet, or assist
in using the Selection tool to accurately cut out a shape.

You can also use the General Options dialog to change the size and
magnification level of the Hot Spot but note that larger displays will
be slower to draw. The Hot Spot also works in Full Screen mode.

E. Zoom Mode

Another way of obtaining a magnified display is to use Zoom mode.
Although this does not provide all the normal drawing tools, it is ideal
for detailed editing or touching up small areas of the image. It works
as follows:

Select Zoom from the View menu to enter Zoom mode. The image
(or selected area) will become magnified and a special Zoom
mode toolbox display will appear.

Click on the magnifying glass icons to zoom further in and out of
the image and use the window scroll bars to move around as usual.
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You can select one of three dot sizes for drawing or use the Zoom
mode Fill tool. Click on the drawing area to use these tools.

Use the colour wheel or palette display to change the drawing
colour as normal.

Once you are finished editing, selecting Zoom from the menu a
second time will exit Zoom mode.

Most of the menu options are also available in Zoom modé and you
can Undo or enter Full Screen mode as required. Note that there is a
different set of keyboard shortcuts for use in Zoom mode,

Co-ordinates

There are a number of options which help you locate exact positions
on the image by means of a co-ordinate numbering system. The X co-
ordinate is the distance across the image whilst the Y co-ordinate is
the distance down.

By default, the exact centre of the image has both X and Y co-
ordinates of zero and this point is known as the origin. X co-ordinates
to the left of the origin and Y co-ordinates above it are negative
numbers. You can reposition the origin via General Options or using
the Ruler display.

Selecting the Co-ordinates option from the View menu will
continuously show the X and Y pixel co-ordinates of the mouse
pointer. The' co-ordinates are displayed immediately above the
toolbox in each window.

The Rulers

In addition to co-ordinates you can switch on the Ruler display. You
can use either or both of these displays to assist in accurate placing or
measuring - to draw a square of exactly 20 pixels wide for example - or
to ensure that two shapes are of identical size.

As the name suggests, the rulers are horizontal and vertical bars next
to the drawing area which show co-ordinate numbers. To switch these
on or off you should:

Select Ruler from the View menu to get the Ruler Options dialog.
Click in the Ruler On/Off box.
Click on the OK button.
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Conclusion

If you have been following each of the tutorials through, you have now
covered all of the main features of TruePaint. You will probably want
to make use them by creating some of your own pictures. For practise,
it can also be helpful to try copying existing pictures onto the
computer, using the techniques and effects that you have learned.
Once you feel confident with TruePaint, you might want to try
animating some of your images too.

Use the Reference chapter and index to check up on any options that
you are unsure about. You may also find it interesting to read through
the Background chapter if you have not already done so.

Good luck!
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Animation

This section describes the use of TruePaint’s animation facilities. It discusses
the way that animations work, how they are created and also suggests some

techniques

you can use in designing your own animations. It is recommended

that you familiarise yourself with TruePaint before attempting to create your
own animations.

Introduction

Computer animation basically works in. much the same way as
television or moving film, by rapidly displaying a series of individual
still pictures one after another to produce the illusion of continuous
movement. '

Moving Objects

To give the effect of an object falling from the sky for example, the
first “frame’ would be a picture of the sky showing the object in its
initial position. The second frame would show the same background
but with the object at a slightly lower position, the third much lower as
the object gathers momentum and so on.

When played back in sequence, your eye would follow the object and
it would appear to move. The faster the frames are replayed, the
smoother the movement appears. Conventional film for example is
normally played at a rate of around 25 frames per second.

Ring Motion Animation

Of course there is more to it than simply moving objects about.
Consider an animation of a walking figure. Not only does it need to
move but its arms and legs must also be animated, otherwise it would
appear to mysteriously slide or skate along rather than walking!

TruePaint

Animation Page 65



This is done by preparing a number of individual frames of the
walking figure, all based upon the same graphic but each at different
stages of walking. The first frame would show the figure ready to take
a step forward, the next would have one leg slightly outstretched, a
few frames later the figure would be in mid-stride and so on.

Only one ‘cycle’ of the animation need be drawn in this way since this
sequence repeats. The same frames can be reused for each forward
step, although care must be taken to ensure that they are placed on
the background frames so that the foot positions match up correctly.
This technique is known as ring motion animation.

Creating Your Own Animations

Animation does take some skill and practice (you will probably get
much amusement from your initial attempts!), some careful
observation of both real life and cartoon images can help too. If you
own a video recorder with a good freeze frame or frame advance
facility, you can use this to watch how professional animators create
various effects and try to mimic these in TruePaint.

It is best to start off with something simple so that you can get
acquainted with the animation options, a bouncing ball for example
or a pair of eyes that look from side to side. A walking stick figure or a
cartoon character provide more of a challenging project.

TruePaint by no ‘means restricts your animations to simple objects
moving around a static background. In practice, your animations may
be as complex as you like. A combination of moving objects,
animated backgrounds and complete changes of scene can be used
with the final animation often being assembled from a number of
individual pictures. Some hints and tips can be found at the end of
this section. Let your imagination loose!

Memory Requirements

Rather than storing each individual frame in memory, TruePaint only
stores the initial image. Subsequent frames are remembered by the
differences from the previous frame, requiring less memory, disk
storage and also allowing better playback speeds. This means that
you can create longer or smoother animations since more frames will
fit into memory at once. Remember to check that the animation is not
too big to fit on disk though!
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Because of this, a ten frame animation usually takes up much less
memory than ten individual pictures although this depends on the
animation. The more movement taking place in each frame, the
greater the memory requirement will be. So, a picture with little
movement takes up only slightly more space than a static image,
whereas a fully animated backdrop requires much more. Smaller
images also require less memory.

Conserving Memory

If you are unable to add further frames to your animation then you
have run out of memory. You may be able to recover some by closing
any windows or desk accessories that are not required and using the
File Formats option to unload some file managers. Do not unload the
one you are actually using since you will need it when saving your
animation, unless you are using the built-in TruePaint animation
format.

Removing animation frames or reducing the amount of movement
between each frame will also increase the amount of available
memory. \
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The Animation Options

Each of the TruePaint animation options is described in detail below, starting
with an explanation of how to build up an animation sequence.

Building an Animation

Each frame of the animation is created with the usual drawing tools in
exactly the same way as a still image. Think ©f the animation as a
stack of separate images, only one of which is visible through the
window at any given time.

an animation sequence-with frame 3 being viewed

The sequence is built up by adding frames one at a time. When
creating a new animation this is normally done by drawing a single
frame then using New Frame at End to create the next. You can then
adjust the picture accordingly without having to redraw the entire
image. This process would be repeated for each successive frame.
Alternatively, first create as many blank frames as you think will be
required and then draw each one individually from scratch.

Extra frames may be inserted anywhere in the sequence with New
Frame  After. If at any stage you wish to reorder or copy frames then
you can use the Edit menu’s Cut and Paste commands in Full Screen
mode.

To move between frames using the keyboard, type a left or right arrow
symbol: € or> (this may involve holding down the Shift key, depending
upon your keyboard). Right arrow will move forward a frame, left
arrow moves back to the previous frame. These controls stop when
you reach either end of the animation and so do nothing if there is
only a single frame.
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Animation Options

All of TruePaint’s animation facilities are accessed via the Animation
menu item on the Options menu. Selecting it produces the following
dialog box.

Length of Sequence: 881
[ ]

the Animation Options dialog

These options allow you to add, delete and edit individual animation
frames. By selecting Animate from the View menu you can actually
replay the animation, although there must of course be more than
one frame in the sequence to do this.

Frame Numbers

Each animation frame is numbered, with the first frame being frame
1. The total number of frames is shown in the Length of Sequence
indicator at the bottom of the Animation Options dialog and this is
the highest frame number which can be entered. For a still image this
will always be one.

You can type in a frame number from the keyboard, using Esc or
Backspace to rub out the existing value. This is the frame which will
be used for the operations described below. It can also be used jump
quickly to any particular point in the animation. Note that the frame
number you enter must actually exist.

To simply view the frame, click on Apply. You can use this to check
that you entered the right frame number before clicking on OK or
closing the dialog to resume editing. Use Cancel to exit leaving the
frame number unaltered.
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New Frame After

Clicking on this button will insert an extra frame in the animation,
after the given frame number, and position you on that frame, ready
for editing. The newly created frame will be an exact copy of the
existing one. This can be used to create more ‘in between’ frames in a
sequence for smoothness.

adding a new frame after frame 3

Note that adding a frame into the middle of an animation causes all
the frame numbers after this point to increase by one. Length of
Sequence should also increase by one. If this does not happen, it
means that you have run out of memory.

New Frame at End

As you might have guessed, New Frame at End is similar to New
Frame After except that it creates a new frame at the end of the
animation sequence; It always has exactly the same effect, regardless
of the frame number. The new frame will be a copy of the existing
final frame. This is often used when initially creating an animation by
adding a frame and then modifying it to create successive frames.

adding a new frame to the end of the sequence

Remove Frame

This deletes the given frame number from the sequence altogether,
decreasing the length of the sequence by one. As with inserting a
frame, this also affects the numbering of any frames after this point.
Be careful with this option since removed frames cannot be
recovered!
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removing frame number 3

To lose all of the frames and start again it is usually quicker to simply
close the window and use New, whereas if you wish to clear the
current frame, use Delete on the Edit menu instead.

Animate Mode

Selecting Animate from the View menu with an animation sequence
present takes you into Animate mode. This is where you can replay
the animation at speed using the whole screen. Initially, the first
frame of the animation will be shown with a bar containing various
icons at the bottom of the display.

P | =pelay: e2sEE <> JJEXIT
the Animate icons

To use any of these controls either press their keyboard shortcuts or
position the mouse pointer over the icon and click the left mouse
button as for a drawing tool. Note that the normal keyboard shortcuts
are not available from Animate mode.

If your computer and monitor support overscan, you can obtain a
larger display which extends beyond the normal screen borders by
switching on the View menu Overscan option before entering
Animate mode.

s Play Return

The Play button is used to actually run the animation sequence. Each
frame will be shown in turn at the specified rate. The animation will be
played continuously, returning to the beginning after the last frame
unless Ping-Pong is selected in which case it will also be played
backwards. To stop playback, hit any key on the keyboard.
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EXIT

Delay +o0r-

Delay determines the speed of animation playback by adjusting the
amount of time each frame remains on the screen. Clicking on the
minus button will speed up playback whilst the plus button slows it
down. Note that it is easiest to use the numeric keypad for the
keyboard shortcuts.

As mentioned previously, a faster rate of playback can improve the
smoothness of the animation but this also requires a greater number
of frames and more memory to achieve a sequence of the same
duration.

Ping-Pong P

Animation normally cycles round from the first to the last frame,
looping back to the start once finished. When the Ping-Pong icon is
highlighted however, the frames will be played first forward and then
in reverse order so that the animation appears to ‘bounce’ back and
forward, doubling the effective length of the sequence.

If you design with this feature in mind then you can create longer
animations out of fewer frames, although it only works for certain
sequences. For example, an eye opening and closing could easily be
done with Ping-Pong mode, but it would be less useful for an apple
falling from a tree since the apple would then appear to bounce off
the ground right-back onto the tree!

Exit Esc

Clicking on the Exit icon will return you to the regular TruePaint
window display and the Animation Options dialog so that you may
continue drawing and editing.
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Useful Techniques

To assist you in creating animations of your own, this section describes some
useful time-saving techniques to simplify the process plus some ideas that you
might want to incorporate in your animations.

Backgrounds

Many animations take place on a relatively static background.
TruePaint takes advantage of this to reduce the amount of memory
required for each frame. Because of this, it is often easier to initially
draw the background as a separate, static image to which foreground
and movement can later be added.

Once you have prepared a suitable backdrop see if you can make it
more interesting and realistic by adding motion. For example, water is
rarely perfectly still and plants stir in the breeze. Changing an area’s
colour can be used to simulate the effects of light and shade, or as a
special effect. Spending time over such background detail will greatly
add to the overall quality of your animation.

Creating Interaction

The backdrop need not be just a pretty picture. Where possible, try to
create some element of interaction with the foreground so that
objects appear move into and out of it, not just across the front of it.

To create the effect of, say, a tiger walking through the jungle, you
could build the picture out of several layers. The first layer would
consist of the ground, sky and distant trees. The animated tiger would
then be pasted onto this background with the final layer of
foreground trees pasted over the top of the whole animation so that
the animal can only be seen through the foliage.

Perspective and Distance

Adding convincing depth to your animations can be quite a difficult
task. You can use the Rays tool to help with perspective drawing as
described in the tutorials and good use of colour will also add realism.
Distant objects tend to appear more ‘washed out’ so use muted greys
and blues for these rather than bright colours.

TruePaint

Animation Page 73



To create the effect of something moving into the distance, use Resize
to shrink it down in successive frames. Always draw the largest size
manually to avoid blocky pixel effects when resizing. You might want
to sketch out the path that the object follows first to ensure a smooth
progression and either note down co-ordinates or selectively erase it
later with the Brush tool.

Animated Objects

Animated foreground objects are usually best created as completely
separate animations which you then Paste onto-the background. To
do this, create a new image of the required size and draw the first
frame of the animated object. It is important that you retain the
default background colour at this stage.

Remember that in palette-based modes, the colour palette you use
for all your animated objects must be exactly the same as that of the
background to prevent colour matching problems later on. Of course,
True Colour mode does not have this problem.

Adding Frames

After drawing each successive frame, select New Frame at End and
use it to form the basis for the next frame. This ensures that each
frame matches correctly and will save you time since only the sections
which move need to be redrawn. For animations that repeat it is only
necessary to draw one complete cycle although you must make sure
that the first frame follows on smoothly from the last.

You may prefer to create all the frames within a single image instead
and use Copy and Paste to start each new frame. Although this makes
it easier to compare different frames, it will not be possible to test the
animation before pasting it onto the background.

Assembling Your Animation

The advantage to building up each element in this way is that it gives
you complete flexibility when assembling the final animation.
However, it is important to save each of the component parts to disk
before assembly. This allows you to make mistakes without ruining all
your work and you can even reuse sections in other animations.
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Creating the finished product is a matter of using Copy and Paste to
construct each frame. The successive frames of objects should be
pasted onto the background animation, changing their positions
between frames accordingly. Use the arrow key shortcuts to flip from
frame to frame to ensure continuity. Transparent Write Mode along
with use of the default background colour will ensure that the pasted
objects do not leave solid blocks around them. See the Cuf and Paste
tutorial for details.

The Grid, Co-ordinates and Ruler options also come in handy for
placing objects at the required positions. For smooth and even
movement, try using Snap to Grid and pasting each frame one grid
line further on from the last. Realistic acceleration effects can be
achieved by increasing the number of steps moved by the same
amount each frame. '
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Reference

The Reference section covers each of the TruePaint icons, menus and dialogs. It

is divided

into two parts describing the toolbox and the menus. Dialog boxes are

to be found alongside the associated tool or menu item.

The Toolbox

This section describes each of the TruePaint tool icons that appear in
the toolbox area at the left side of each window. There are three
different toolbox displays which are selected by the three icons at the
top of the toolbox, or by pressing 1, 2 or 3. These are Drawing Tools,
Palette and Patterns. There is also one other toolbox display that only
appears in Zoom mode which is detailed later.

the three toolbox icons

A tool may be selected by moving the mouse pointer over its icon and
clicking the left mouse button. The currently selected tool is indicated
by a reverse colour icon.

The Drawing Tools 1

There are eighteen different drawing tools which appear in the
toolbox when the above icon is selected. This is the default toolbox
display. A drawing tool may be activated by clicking once on its icon
or by pressing the appropriate single key shortcut.
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Many of these tools have an associated Tool Attributes dialog
containing additional settings, in which case double-clicking the tool
icon or pressing its keyboard shortcut with Shift held down will reveal
a window. Options menu items such as Rainbow and Shadow may
also be used to alter the actions of various tools.

Note that all drawing is limited to the visible part of the image. Any
part of a shape which falls outside this area will not be drawn. The
Selection tool may be used to further restrict drawing to any
rectangular section of the image.

The drawing tools and associated dialogs are described in left to right
order as they appear on ‘the screen. Keyboard shortcuts are also
shown.

E_I The Pen tool P

The Pen tool is used for continuous freehand drawing. While the left
mouse button is held down over the drawing area, the Pen tool will
paint a continuous line in the current pen colour (shown at the bottom
of the toolbox) as you move the mouse. Release the mouse button to
end the line,

Simply clicking on the image will paint a single dot although the Dots
tool is more suitable for drawing a series of unconnected dots. A
shadow will also be drawn if selected from the Options menu and
Rainbow mode may be used for multicoloured lines. For patterned
drawing, use the Brush tool.

The thickness and shape of the pen is changed via the Line Attributes
dialog which appears when you double-click the Pen tool. Note that
Arrow lines and Line Patterns are not generally useful for freehand
drawing.
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The Pen tool may also be used as an eraser by choosing the
background colour from the Palette display and a wide line thickness.
Drawing on the picture will then appear to ‘rub out’ the image. This
technique also works with the Brush tool and can be used to rapidly
create large areas of colour.

Line Atiributes Shift L

The Line Attributes dialog is used to change the style, thickness and
pattern of lines or shapes produced with many of the drawing tools
and is brought up by double-clicking on an appropriate tool (such as
the Pen or Line tool).

Start: End: Thickness!
Square Square [+]
Arrou Arrod
Rounded Rounded

- =]

Line Pattern:

____EEEER ______HEEE

the Line Attributes dialog

To accept any changes you have made, either close the Line
Attributes window, click on the OK button or press Return. Cancel will
close the dialog without changing the settings whilst Apply starts
using the new attributes immediately, allowing you to resume drawing
without closing the dialog.

For example, to change the line thickness you should:

Click on the Drawing Tools icon at the top of the toolbox if it not
already selected.

Double-click on the drawing tool you wish to use, the Pen tool for
example, to produce the Line Attributes dialog.

Select the required line thickness by clicking on the “+" and *~
buttons at the right-hand side of the dialog.

Click OK or press Return to resume drawing.
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Note that some of the attributes are more useful when used in
conjunction with certain drawing tools.

Start and End

There are three line end styles available: Square, Arrow and Rounded.
The current style is indicated by a filled box and may be changed by
clicking within one of these boxes.

Square line ends give the effect of drawing with a marker pen and are
also suited to creating large areas of colour or erasing part of an
image using thick lines.

Arrow places an arrowhead at the end of a line which varies in size
according to the thickness of the line. This is best used with the Line
or Arc tools to add dimensions or captions to a diagram or drawing.
Some interesting effects can be produced with arrow lines in Rainbow
mode although they do not work well for freehand drawing.

Rounded lines are the best choice for continuous lines and shapes
since they join together neatly at corners. Note that there is no
difference between Square and Rounded line ends for very thin lines.

some sample line styles

Although you would normally use the same style at both line ends, it
is possible to select different start and end styles. If you require a line
with an arrow at only one end for example, you might select Square
for the line start and Arrow for one line end.

Thickness

The current line thickness is shown at the right of the Line Attributes
dialog. Press the left mouse button over the ‘+’ or - buttons to make
the line thicker or thinner accordingly. Thick lines are useful for fast
drawing or colouring whilst finer lines are for detail.

Line Pattern

This allows you to draw patterned or dotted lines instead of a solid,
unbroken line. Note that this attribute only affects lines which are a
single pixel thick; wider lines are always solid.
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The horizontal bar is a magnified representation of the line pattern,
made up of sixteen dots. Clicking at any position along the bar will
switch a single dot on or off. Those that are on are normally drawn in
the pen colour, dots which are off are either drawn in the background
colour or left unchanged from the background depending upon the
Write Mode. With all the dots filled in, a solid line will be drawn.

It is possible to create many different line patterns in this way. For
example, alternate dots give a fine texture to your lines whilst
alternate groups of four on, four off will give a dashed line. Other
sequences such as dot-dash may be useful for technical drawings etc.

~~| The Line tool L

This tool may be used to draw single straight lines in the current pen
colour or Rainbow mode if selected. Line thickness, pattern and start
or end shape may be adjusted using the Line Attributes dialog which
will appear after double-clicking on this tool.

To draw a straight line in the image you should:
Position the mouse pointer over where you want the line to start.

Hold down the left mouse button and drag the mouse to where the
line should end (a ‘rubber band’ effect shows you the length of the
line).

Release the mouse button to draw the line on the image.

A shadow line will also be drawn if enabled. For drawing a series of
lines, the Connected Lines, Rays or Polygon tools may be more
suitable.

The Connected Lines tool N

The Connected Lines tool draws a series of lines, each following on
from the last. It differs from the Line tool in that you press and release
the left mouse button for each point rather than dragging. After
clicking once to start the first line, each successive mouse click draws
a new line starting from where the previous one left off.

To break the line and select a new starting point, simply reselect the
Connected Lines tool. Double-clicking this tool reveals the Line
Attributes dialog.
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You can draw each line segment in a different colour by using the
Palette display to change colour before selecting each end point.
Connected Lines also work with Rainbow mode and Shadow. To draw
an outline of a shape, use the Polygon tool.

The Rays tool Y

Rays are similar to Connected Lines except that they all start at the
same initially selected point. To use this tool you should:

Click once at the position where you want the lines to start.
Move the mouse pointer to the end position of a line and click.

Repeat this process until the desired number of lines are drawn.
Dragging the mouse while holding the left button down will draw a
series of rays.

Select the Rays tool again to select a different starting point, or any
other toolbox icon as required.

Double-clicking on the Rays tool produces the Line Attributes dialog.
See the Drawing Shapes tutorial for a description of how to use the
Rays tool for perspective drawing.

The Grid tool G

This tool is used to draw a rectangular or square grid of lines on the
picture using the current Line Attributes. It is necessary to select the
overall dimensions and grid size as follows:

Hold down the left mouse button over where the grid is to begin,
drag out a box and release the button. This is the total size of the

grid.

Hold the mouse button down again and adjust the grid lines as
required by moving the pointer inside the original box. This sets
the dimensions of each grid square.

Release the mouse button to draw the grid.

In Rainbow mode, this can be used to create a rectangular gradient of
colour by placing the grid lines so close together that they meet.
Interesting effects can also be obtained with grid lines a single pixel
apart so that the original image shows through.
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Double-clicking the Grid tool will reveal the Grid Overlay Options
dialog, also available via Grid on the View menu. This can be used to
overlay a temporary grid on the picture which can be switched off
again at a later stage. See the menu item for details of using grids as a
drawing aid.

/"1 The Arc tool X

The Arc tool draws curves which form the partial outline of a circle or
ellipse. For a more flexible way of drawing different types of curves
use the Curve tool; the Segment tool may be used for filled or wedge
shaped circular sections.

The steps involved in using the Arc tool are:

. Drag out a circle or ellipse of the required size as for the Circle
tool.
. Using the two handles which appear, adjust the length of arc

drawn by positioning the crosshair inside the box, pressing the
mouse button and dragging to the new position.

. You can reposition the arc by pressing the mouse button while the
pointer is inside the complete circle’s area and dragging it to a
new position. Clicking outside this area will cancel the operation.

. Once the desired shape is achieved, double-click to draw the arc.
\D

an arc being drawn

Arcs may also be drawn in Rainbow mode and with a Shadow. If a
perfect circle is required then the Free Form menu option should be
switched off before drawing.
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El The Curve tool |4

This tool allows you to draw a variety of curves including loop and S-
shapes. The curves are Bézier curves, created using four individual
points. For curves which form part of a circle or ellipse you can
instead use the Arc tool. A detailed discussion of Béziercurves and
how to make the best use of them can be found in the Background
section.

Important: either Speedo or Font GDOS must be installed to
use the Curve tool. It will not be selectable and appears greyed
if neither system is available. See Appendix C for details.

Operation of the Curve tool is very simple and involves:

Clicking on four points on the image. The first and last of these are
the start and end points, the other two are control points,
described below.

Adjusting the points by dragging the corresponding handles
around the image. This may be done any number of times to
achieve the desired curve.

Double-clicking over the drawing area to draw the curve. You can
click once to cancel.

The shape of a Bézier curve is determined by the positioning of the
two control points. Unlike the first and last point selected, the line
does not pass through these points. Instead, they distort the shape of
the line, pulling it towards them.

drawing a curve with control points

If the control points are on opposite sides of the curve as above, an S-
shaped curve will result. With the start and end points closer together
and the control points switched over, loop shapes can be created.
Remember that you can always piece several curves or arcs together
to form more complex shapes (see Background).
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Curves may be drawn with a shadow although unlike Arcs, they
cannot be Rainbow lines. Double-clicking the Curve tool produces
the Line Attributes dialog which adjusts line thickness, style and
pattern.

Bl | The Rectangle tool R

This tool can be used to draw both filled and outline rectangles and
squares. The Polygon tool may be used for drawing more complex or
rotated shapes.

Drawing a rectangle is similar to using the Circle tool; press the left
mouse button over where you want the rectangle to start then drag
the pointer to the opposite corner. Releasing the button will then draw
the shape. The Free Form option should be off to draw exact squares.

Rectangles are drawn using the pen colour and fill pattern with an
outline in the current line settings, which may be changed via the
Line Attributes dialog produced by double-clicking the tool icon.
Rounded line ends are the most suitable for drawing rectangles.

For solid boxes, ensure that Filled Shapes on the Options menu is
selected, otherwise only an outline will be drawn. In Rainbow mode,
filled rectangles are drawn as a series of concentric boxes, each in a
different colour, according to the settings in the Colour dialog. The
Rounded Boxes option will change the appearance of each corner of
the rectangle, giving a speech bubble effect.

4 | The Circle tool C

The Circle tool draws either circles or ellipses using the current Line
Attributes, fill pattern and pen colour. To draw a partial circle or
wedge-shaped section, use the Arc or Segment tools. To draw a circle:

. Select the Circle tool by clicking on its icon in the toolbox.

. If you want a perfect circle rather than an ellipse, check that Free
Form in the Options menu is off. For a filled circle, use Filled
Shapes on the Options menu.

. Position the mouse pointer over where you want the centre of your
circle to be.
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Hold the left mouse button down, drag the mouse to create a
shape of the required proportions and release the mouse button
to draw it.

If Rainbow mode is enabled then either a coloured outline or a series
of concentric circles or ellipses will be drawn. For a different type of
rainbow circle, try using the Segment tool.

The Polygon tool o

Although by default the Polygon tool draws triangles, hence its icon, it
can be configured to draw squares, hexagons or even stars, all at any
angle or size (a polygon is simply a multi-sided shape). Polygons are
drawn using the current Line Attributes which may be accessed by
double-clicking on another drawing tool such as the Pen tool. For solid
or patterned polygons, enable the Filled Shapes menu option.

There are two basic methods of drawing polygons depending upon
whether Regular is selected in the Polygon Attributes dialog which
appears when you double-click the tool icon.

oY

non-regular polygons

By default, polygon drawing is similar to using the Connected Lines
tool except that, once the required number of points have been
selected by clicking the mouse on the image, the entire shape is
drawn with the last point automatically connected to the first. Note
that you do not need to drag the mouse with the button down, simply
click at'each point in turn.

ANS D

regular polygons

Page 86

Reference TruePaint



Regular polygons are symmetrical shapes such as equilateral
triangles, squares, pentagons etc. These may also be rotated to any
angle, allowing tilted squares and rectangles to be drawn. The
technique is similar to using the Arc tool:

Position the mouse at the centre of the shape.

Holding down the left mouse button, drag the pointer to
determine the dimensions of the shape. With the Free Form
menu option on, shapes may be horizontally or vertically
stretched.

Using any of the handles that appear at each corner, rotate the
shape as required. Note that the overall' dimensions do not
change, only the position of each side.

Reposition the shape if necessary by pressing the mouse button
with the pointer inside the shape and dragging it around the
screen.

The last two steps may be repeated as necessary until the desired
shape is obtained. Double-click: over the drawing area to draw the
shape or click once to cancel. Note that Rainbow and Free Form only
affect regular polygons.

Polygon Attributes Shift O

Double-clicking the Polygon tool icon will reveal the Polygon
Attributes dialog which determines the type of shape drawn by the
Polygon tool.

Number of Sides: 3|

(] Regular

the Polygon Attributes dialog

After changing the required attributes you can press Return, click on
OK or close the dialog box to accept the changes. Alternatively, click
on Cancel to continue with the old settings or press Apply to resume
drawing with the new attributes without closing the dialog.
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Number of Sides

This controls how many sides the polygon has, which is also the
number of points you have to select when drawing regular polygons. It
may be changed by deleting the existing number with Backspace and
typing the desired number of sides from the keyboard.

Regular

To draw polygons where the shape and length of each side is uniform,
select the Regular box. These are drawn by dragging out the shape
and then rotating it. Otherwise, each point is selected in turn with the
final point joined automatically to the start to complete the shape.
See the Polygon tool for details.

Non-regular polygons are much more flexible as they can be used to
draw or fill irregular and unusual shapes which could not be created
as regular polygons.

The Fill tool | F

Depicted as a bucket of paint, the Fill tool floods an existing area of
colour with the current pen and pattern. Simply click the left mouse
button with the pointer positioned over the area to be filled. Note that
the Polygon, Circle and Rectangle tools will also draw solid shapes
with the Filled Shapes menu option selected.

Some care must be taken to ensure that colour does not leak outside
the intended area. This happens if there is as little as a one pixel gap
or join at the boundary. To avoid this you can use Zoom mode or the
Hot Spot to locate and change such pixels manually. If you find
yourself watching your wonderful picture filling up with green paint
because a fill has leaked, don’t panic! You can always use the Undo
function and try again.

Fill works best on drawn or palette-based images since it only affects
pixels of exactly the same colour. With photographic type images you
may find that only part of an area is filled, especially in True Colour
mode. This happens when there are subtly different shades present
which, although they look the same to you, the computer considers to
be a different colour.

For another way of changing part of an image to a different colour,
see the Brush tool.
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~® | The Segment tool E

The Segment tool works very much like the Arc tool but instead of
drawing only curves, it draws wedge shaped sections of ellipses and
circles and can be used for drawing semicircles, pie charts etc.

shapes drawn with the Segment tool

For a visually accurate circle, switch Free Form off. With Filled
Shapes selected, the segments are filled. For further details, please
refer to the Arc tool.

You may want to use this tool for Rainbow mode shapes since it
produces a different rainbow effect from the Circle tool.

=% | The Dots tool D

This tool may be used for freehand drawing in a similar way to the Pen
tool except that it draws individual points rather than a continuous
line. Press the mouse button over the image once for a single dot or
hold it down and-drag to draw a trail of dots. Moving quickly will give
widely spaced dots.

4 K O X &

the six available dot types

In addition to drawing single pixel points, the Dots tool can be used to
draw a variety of shapes for producing special effects or textures. To
select the type and size of dot, double-click on the Dots tool icon to
reveal the Dot Attributes dialog.
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Dot Atiributes Shift D

Size

The Dot Attributes dialog gives you access to the different dots and
sizes used by the Dots tool and is produced by double-clicking on this
tool.

Size: Type:
o Dot
Plus
Asterisk
Square
5 Cross
Diamond

the Dot Attributes dialog

To accept any changes you make, either click on OK, close the dialog
or press the Return key. Cancel will restore the settings prior to calling
up the dialog and Apply will use the new attributes for drawing
without closing the dialog,.

There are eight different sizes available for each type except Dot
which may only be a single pixel in size. Press the mouse button over
the up arrow to increase the dot size or the down arrow to decrease it
(note that you should hold the left mouse button down rather than
just clicking it). The size display lets you preview the dot as you vary
the controls.

To select any of the six dot types, click in the box next to its name. The
size display will show you the actual dot shape. The currently selected
dot type is indicated by the filled box.

Page 90

Reference TruePaint



“"@| The Airbrush tool A

The Airbrush tool is used to give a spray effect similar to that
produced by an artist’s airbrush. Pixels of the selected colour are
scattered randomly over the area around the pointer when you draw.
The size of this area and the rate at which colour is sprayed are
adjustable via the Airbrush Attributes dialog, available by double-
clicking. For example:

Select the Airbrush tool by clicking on its icon.

Choose the colour to spray onto the picture using the Palette
display.

Position the mouse pointer over the drawing area where you want
to apply some colour.

Holding down the left mouse button, move the mouse across the
area that you wish to colour. Note that the Airbrush tool only adds
more colour as you move the mouse around; just holding down the
mouse button will only spray momentarily.

This tool is very useful for shading pictures or blending one area of
colour into another since it creates a mixture of colours rather than
uniform areas. In Rainbow mode, the entire range of rainbow colours
will be used.

In True Colour modes, similar effects can be achieved using the
Brush tool, with the added advantage that it uses many different
colours to produce its smoothing and tint effects, giving a more
realistic result.
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Airbrush Attributes Shift A

Double-clicking on the Airbrush icon will reveal the Airbrush
Attributes dialog. This is used to adjust the size of area covered by the
Airbrush spray and the speed at which colour is sprayed.

Flom Rate:
6 (Fast)

5
o

1 (Slow)
--ﬁ

the Airbrush Aliributes dialog

Nozzle Size:

Click OK, close the dialog or press Return to accept any changes you
make or Cancel to leave all attributes as they were. Apply will use the
new settings for drawing witheut closing the dialog.

Nozzle Size

This is the region around the mouse pointer over which the airbrush
effect will be added. The Airbrush tool will only spray pixels within this
area. Small nozzle sizes are ideal for detailed work, larger sizes are
better for creating texture.

To adjust the nozzle size, press the left mouse button while the mouse
is over one of the arrows. Up increases the size, down decreases it. The
nozzledisplay to the left of the arrows will vary as you use the controls.

Flow Rate

The flow rate affects the density of the airbrush, changing the amount
of colour sprayed on the image each time you move the mouse.
Density is also affected by the speed at which you move the mouse,
moving faster produces a lighter spray.

There are six flow rates available. For a dense colour, select a higher
number for a fast flow rate. For a more sparse airbrush effect, use the
slower rates. Note that high flow rates are less suited to use with small
nozzle sizes.
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The Text tool T

To add text to your images, select this tool. Combined with the options
in the Text Attributes dialog (produced by double-clicking) it is
capable of drawing many different fonts and styles including Speedo
or Font GDOS fonts. However, its basic operation is very simple:

Select the Text tool icon from the toolbox.
Move the mouse pointer into the drawing area.

Start typing! The text will appear under the mouse pointer as you
type and you can use Backspace to rub out any mistakes.

To reposition the text, move the mouse around whilst holding the
left button down. You can change the position and colour of text or
continue typing any number of times before actually writing it on
the image.

Once you are happy with the results, press Return or double-click

to draw the text on the image in the current pen colour and Write
Mode. \

For further details of how to add teéxtto your pictures and make use of
the various Write Modes, please refer to the Adding Text tutorial.

Note: none of the TruePaint keyboard shortcuts are available
while the Texttool is active.

Text Attributes Shift T

This dialog lets you set the font size, style and direction used by the
Text tool, See the discussion of fonts in the Background section for
further information.
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¥Americana Bold
#Embassy
#*Monospace 821
#Monospace 821 Bold @
#Dom Casual

xotic emi-bBo
#Bitstream Cooper Black
#Bitstream Charter
#Bitstreamn Charter Italic
#Pica 10 Pitch
#Bitstream Charter Black o
#Bitstream Charter Black Italic
#P.T. Barnum

Reset Skew:[ | Effects:  Wid: 35
Bold Hogt: 3

‘B Light
Italic

Underline

Outline

Angle: B..

the Text Altributes dialog

To accept any changes simply click on OK. The Text tool will then
proceed to use the new text attributes. Pressing Return or closing the
dialog have the same effect.

Important: many of these features are only available if you
are running Speedo or Font GDOS. Please refer to Appendix C
for details.

Font

All of the available fonts are displayed in a list at the top of the Text
Attributes dialog. Outline fonts (i.e. Speedo or Font GDOS fonts that
can be scaled to any size) are marked with an asterisk. If there are
more fonts in your system than fit in the window you can click on the
arrows on the right to scroll through them.

A font is selected by simply clicking on its name. The current font is
indicated in the list by a highlighted bar. A sample of its appearance
in the current size and style is shown at the bottom left of the dialog.
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Width and Height

Effects

Text size is varied by changing the width and height of the font which
can be done in two ways. Firstly, you can click on the Wid or Hgt
indicator in the Text Attributes dialog and type the required size from
the keyboard, using Backspace or Esc to rub out. Pressing Return will
update the display. This is useful for quickly changing the font size by
a large amount.

Alternatively you can click on the four arrow buttons using the mouse.
The up and down arrows increase and decrease the font height
whereas left and right adjust the width. The sample text display
automatically displays the new sizes as you use these controls. Simply
hold the left mouse button down until it shows the correct size.

In most cases it is best to use the same font width and height so that
text does not appear distorted. Note that for fonts not marked with an
asterisk, only the height may be adjusted. The width is set
automatically so that the font appears in the correct dimensions.

The effects change the appearance of a font and can be applied
either singly or in combination. To switch an effect on or off, click on
the labelled box.

Bold makes text darker by thickening all the lines in the font and may
also make the téxt wider. If you already have a bold version of the
font, use that instead.

Light draws the text using a pattern of dots instead of a solid colour.
This gives a ‘ghosted’ effect similar to unavailable menu items. For
more complex textured effects, see the Tutorials section.

Italic has the effect of slanting all the letters in the font. Although this
simulates italics, it does not give as good results as a true italic font.
You can also use the skew facility for greater control over the slant
angle.

Underline simply places a line below the text at the correct position
whereas Outline draws each letter as an unfilled outline, also making
the text slightly wider. This effect is often particularly effective in
conjunction with Bold.
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Angle

With an outline font it is possible to skew or slant each letter to give
forward or backward italics, although it is often better to use a real
italic font or the Italic effect. Note that this is different to the text
angle which draws text on a gradient.

To change the skew angle, position the mouse pointer over the
sample text display and hold down the left button. The text will be
skewed to the left or right depending upon which half of the box you
click in.

To reset the skew angle, click in the Reset Skew /box above the sample
text display.

One of TruePaint’s most useful text drawing features is the ability to
rotate fonts to any angle. To change the slope upon which text is
drawn, click on Angle and use Backspace and the number keys to
type in an angle between 0 and 360 degrees.

The angle is normally 0 for left to right text on a straight line. An angle
of 90 will give sideways text reading from bottom to top, 180 is
completely reversed etc. To change the slant of the actual letters
themselves you should use skew.

Note: although any angle may be used for outline fonts, only
multiples of 90 degrees are available for bitmap fonts.

The Pick Colour tool I

As an alternative to using the Palette display or Colour Options you
can simply pick a colour from the image itself with the Pick Colour
tool. This is ideal for ensuring an exact colour match with part of an
existing picture. To do this:

Select the Pick Colour tool by clicking on its icon in the toolbox.

Move the mouse pointer over the image and press the left mouse
button to choose a colour.

With the mouse button still down you can move the pointer
around until the Pen Colour indicator shows the desired colour.
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If either Rainbow 1 or Rainbow 2 is selected in the Colour Options
dialog then the Pick Colour tool will also change this colour, which is
very useful when selecting colour ranges for the Brush tool.

The Brush tool B

The Brush tool provides a variety of colouring and blending effects.
These work best in True Colour mode, making use of the wide range
of colours and shades available, although most of the Brush effects
work in palette modes too. Note that the Airbrush tool may also be
used for shading.

The precise action of the Brush tool depends upon the current Brush
Attributes settings which are available by deuble-clicking. However,
the basic technique is normally the same:

Select the Brush tool icon. You may double-click to adjust the
Brush Attributes if required.

Move the mouse pointer over the drawing area. A box
representing the size of the brush will appear.

Hold down the left motise button and move the mouse to apply
the chosen brush effect to 'the boxed area (just like using the
Airbrush tool) or click once to apply the effect a single time.

If the Area brush mode is selected then you should instead drag out a
rectangle. See the Brush Effects tutorial for further details.

The default brush effect in True Colour mode is to smooth the area
under the brush. In palette modes it draws the current fill pattern.
You may wish to use this instead of the Pen tool for erasing, either with
the background colour or a blank pattern.
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Brush Atiributes Shift B

Double-clicking on the Brush tool icon in the toolbox will bring up the
Brush Attributes dialog used to select the size, shape and effect of the
Brush tool.

| Brush Attributes

Brush Size: ___ Brush Mode:
o Pattern
Replace Range
Outline Range
Smooth Tint
Swap Ranges
Lighten
Darken
Brush Shape: || Tint
Square Leave Range
Circle Smooth
Area Rainbow 1 Range: 258|

[ Cancel | | Apply | Lo |

[TTTTTI

the True Colour Brush Attributes dialog

After making any changes, OK, Return or closing the dialog will
resume drawing. Cancel willignore the changes whilst Apply uses the
new settings without closing the dialog box.

Brush Size

This determines the size of square and circular brushes. A small
brush size is useful for detailed work whereas a larger brush is faster
for large areas of colour. To adjust the size, click on the up or down
arrows. The actual brush size is shown in the dialog,.

Brush Shape

You may choose a different brush shape by clicking in one of the
Brush Shape boxes. Square and Circle simply vary the brush shape
that appears beneath the mouse when drawing. Area differs from this
in that it allows you to drag out a rectangle over which the effect is
applied.

A circular brush is especially suitable for tinting and smoothing
effects since rounded edges tend to look more natural.

Page 98 Reference TruePaint



Brush Mode

The various brush modes are what gives the Brush tool its flexibility.
To fully understand each mode it is a good idea to use TruePaint to
experiment. However, they do fall into several basic categories.

Pattern is by far the simplest mode. The brush is used to draw the
current fill pattern onto the image in the pen colour. You can use this
to ‘colour in’ or erase part of the picture.

Smooth is also fairly straightforward. It smooths the area under the
brush to give a smudged or blurred appearance. This is ideal for
softening boundaries between different colours for shading etc.
Smooth is only available in True Colour mode but Smear may be used
instead for palette modes to give a similar effect.

Tint Modes

Lighten, Darken and Tint all affect the colour of the image. Tint adds
the current pen colour to the area under the brush and is only
available in True Colour mode. It gives the effect of a translucent
colour wash or a more realisti¢ airbrush. The more tint applied, the
closer to the pen colour the area becomes. Tint can be used to great
effect with photographic type images to alter colours and is best
suited to a circular brush shape.

Lighten and Darken are similar except that they tint towards white
and black respeéctively. They are often used to add highlights or
shading to a picture. In palette-based modes they change each colour
to the next or previous colour in the palette, only generally useful for
ordered or grey scale palettes. Smooth Tint is a combination of both
Tint and Smooth giving a sort of water-colour wash effect.

Colour Change Modes

The remainder of the brush modes change an area from one colour to
another. They all work on a range of colours based around the
Rainbow 1 colour selected in Colour Options. The Rainbow 1 Range
determines what other colours are affected, i.e. how similar to
Rainbow 1 a colour has to be before it is included in the range altered
by the Brush.

Replace Range changes all colours in the range to the pen colour. To
change all shades of blue to green for example, you would select blue
as the Rainbow 1 colour (using Colour Options or the Pick Colour tool)
and green as the pen colour, then use the Brush tool over the relevant
parts of the image.
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Leave Range does the exact opposite, only changing colours not in
the range to the pen colour. This can be used to selectively erase only
those parts of an image which are a certain colour. Outline Range
draws a single pixel border around colours in the range, ideal for
outlining text or drawings.

Finally, Swap Ranges converts everything in the Rainbow 1 range to
the current pen colour and changes colours in the range of the pen
colour to Rainbow 1, thus swapping the colours. Always use this mode
with an Area brush.

Rainbow 1 Range

Along with the Rainbow 1 colour, this determines the. colours affected
by the above brush modes in True Colour. A range of 1 will include
only the Rainbow 1 colour itself. Higher numbers will extend the
range to cover the colours close to Rainbow 1. Simply click the mouse
over the colour range and use Backspace and the number keys to
enter a new range.

The Selection tool S

The Selection tool has two functions: specifying an area for Edit or
Effects menu operations (Copy, Delete, Resize etc.) and to restrict
drawing to a rectangular section of the image. You can select an area
as follows:

Choose the Selection tool from the Drawing Tools display.

Move the pointer over the image, hold down the left mouse button
and drag out a rectangle (just like the Rectangle tool).

You can click inside the rectangle and drag it to a new position or
use the handles at each corner to adjust its size any number of
times so that it exactly covers the area you want to select.

The drawing tools and many of the menu commands (some of which
are only available when an area is selected) will proceed to use this
area rather than the entire screen. Note that only the visible part of
the selection is actually used.

To deselect an area, simply click outside it with the Selection tool
active. A quick way of selecting the part of the image you can see is to
use Select Visible on the Edit menu. To select a larger area you must
use Full Screen mode.
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EI The Pen Colour indicator

The Pen Colour indicator is the box below the drawing tool icons
which shows the currently selected pen colour used for drawing lines,
shapes etc. Double-clicking on it will reveal the Colour Options dialog
also available from the Options menu.

To change the pen colour you can use the Palette display, Colour
Options or the Pick Colour tool. Note that if Rainbow mode is on,
many tools will use the selected Rainbow colours rather than'the pen
colour.
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The Palette Display 2

The centre icon at the top of the TruePaint toolbox is the Palette icon.
Selecting it or pressing 2 will switch the toolbox to a palette display
which allows you to choose the pen colour. Other ways to selecta new
pen colour are the Colour Options dialog and the Pick Colour tool.
Note that you may continue drawing from the Palette display with the
current tool if you wish.

There are two different palette displays depending upon whether you
are using a palette-based mode or a True Colour mode. See the
Background section on colour for an explanation of the difference.

Palette Mode

In palette-based video modes, the Palette display is divided up into
coloured rectangles, each representing a different palette colour.

a 16 colour Palette display

Selecting a new pen colour is simply a matter of clicking on one of
these boxes in the toolbox. The current pen colour is indicated by the
outlined box.
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If you want to draw in a colour other than those shown, you will need
to change the palette using the Colour Options dialog, available from
the Options menu. Double-clicking on a palette colour will also bring
up this dialog to let you adjust the colour. Remember that changing
the palette also affects the colours in your picture. See the Colour
tutorial for details.

Note that some palette colours may be identical to others, in which
case you will be unable to differentiate between them on the image.
However, since they are still separate palette colours, their actual on-
screen colours can still be changed individually.

True Colour Mode

In True Colour mode, you have a much wider choice of colours since
the display is not limited to showing only certain colours from a fixed
palette. The True Colour Palette display consists of a colour wheel and
shade bar, described in the Background and Tutorials sections.

o

the True Colour Palette display

Around the edge of the wheel are the pure colours of the spectrum
which become progressively paler as you move towards the centre.
The shade bar immediately below the colour wheel allows you to
darken these colours. The actual pen colour is shown at the bottom of
the toolbox.
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To select a colour you click on the colour wheel and shade bar. As with
the Pick Colour tool, you can drag the mouse around with the button
held down until you locate the desired colour. Selecting a colour is

usually a two stage operation, first choosing a base colour and then
selecting a shade.

For more precise control you can double-click on the pen colour to
bring up the Colour Options dialog box.
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The Pattern Display 3

The Pattern icon gives you access to the third toolbox display which
allows you to select a pattern for filled shapes and the Fill tool.

the Pattern display

There are 36 fixed pre-defined patterns plus another 14 that you can
create yourself using the Define Fill Pattern dialog (accessed by
double-clicking on-one of the patterns or the Fill tool).

Choosing a_pattern is very simple, you just click on the one you want
to use. The solid colour fill pattern should be chosen if no pattern is
wanted. The selected pattern is shown in colour at the bottom of the
toolbox. Note that shape outlines are always drawn in the pen colour.

Pre-defined Patterns

The pre-defined fill patterns are always drawn in the current pen
colour and cannot be changed. With the default Write Mode, the
background colour will be the first palette colour, or white in True
Colour mode.
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User Fill Patterns

Each user fill pattern can either be multicolour or single colour.
Unlike the pre-defined patterns, multicolour patterns may contain
any combination of colours. They always appear in the same colours,
regardless of the current pen colour and are shown in the toolbox in
full colour.

Single colour patterns are those which only use the first two palette
colours, or black and white in True Colour mode. Although this is how
they appear in the Pattern display, they can be drawn in any colour by
simply changing the pen colour (like pre-defined patterns).

Define Fill Pattern Shift F

This dialog is used to modify the user fill patterns. It is accessed by
double-clicking on either the Pattern display or the Fill tool.

o | Define Fill Pattern

Pattern: plour}

h“ll

the Define Fill Pattern dialog

Click on the OK button or close the window to resume drawing.
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Pattern

The pattern being edited is displayed both magnified and at normal
size. Clicking on the magnified pattern will add pixels of the selected
colour. Hold the mouse button down if you wish to draw a series of
dots. You can use the arrow buttons to select different user fill
patterns as required.

Clear and Fill

Colour

Both of these buttons erase the existing pattern, filling it with a single
colour. Clear uses the background colour whilst Fill uses the selected
colour.

To choose which colour is added to the pattern when you draw, use
the palette or colour wheel in the normal way. The vertical bar at the
right of the dialog shows the currently selected colour.

When creating single colour patterns, only use the first two
palette colours or pure black and white in True Colour mode.
Using colours other than these will cause them to be
multicolour patterns, always drawn in the same colours rather
than the pen colour.

Load and Save

Individual patterns can be stored on disk using the Save button and
retrieved using Load. You can use this facility as a way of copying one
fill pattern to another. To save all of the patterns at once, you may use
the Save Setup option.

Clicking on either of these buttons produces a file selector (described
in Getting Started) for you to specify the name and location of the
pattern file. It is recommended that you save patterns in a separate
folder with the default extension of .PAT.

TruePaint

Reference Page 107



The Menus

TruePaint has a number of menus each containing a number of
related actions, options or dialog boxes. To select a menu item, move
the pointer over the appropriate menu title, down over the required
item and press the left mouse button once. Some menu items are
only available under certain circumstances as described. For a more
detailed discussion on the use of menus, please refer to the Getting
Started section.

The various menus and menu items are described in the order they
appear within the program. Keyboard shortcuts are listed alongside
each option where applicable.

The TruePaint Menu

About

The TruePaint or TP menu is commonly known as the Desk menu
because it contains any resident Desk Accessory programs. Only the
first item on this menu is actually part of TruePaint itself, all others
are either Desk Accessories or part of the Desktop.

If your computer is running MultiTOS then you can also use this
menu to switch between applications. The menu title confirms that
you are currently within TruePaint.

TruePaint Help

This option brings up a window giving you information on your version
of TruePaint. Simply click on the close box to remove the window.

It'is important that you quote the exact version number from
this window when contacting HiSoft so that we know which
version of TruePaint you are running,.
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The File Menu

The File menu contains options related to windows and storing picture files on
disk. An explanation of how to load and save pictures along with details of the
file requester and window controls can be found in Getting Started.

New

e

Open... AD
Open As...
Close AU
Save AS
Save fs...
Revert

v ot e e st s oo st o o e o e e et ot e e

e o e i s i o o o g s i e 20 g o

the File menu

Control N

This menu item creates a blank, untitled image window, ready for
drawing into. You can create as many new images as you like, limited
only by available memory, up to the maximum allowed by the
operating system. Selecting New brings up the New Image dialog box
which allows you to choose the exact dimensions of the image.

Width: 326/

Height: 200_
[cancel | [ Screen [ o ]

the New Image dialog

For a full screen sized image, just click on the Screen button or OK to
use the sizes shown. You can enter an exact pixel width and height
from the keyboard, using Backspace or Esc to rub out the existing
sizes after clicking on each dimension.
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Selecting Cancel or closing the dialog will abandon the operation. To
close an image window after it has been opened, simply click on its
close box or select Close from the menu. Note that you cannot
change the size of an image after it is created, instead you must copy
and paste it into another image of the required size.

Control O

The Open command is used to load existing pictures and animations
from disk. A new window is automatically created for each opened
file. You can even load the same file into several different windows at
once if you wish. To reopen the current file, losing any changes you
have made, use Revert.

Selecting Open produces a file selector for you to choose a file to load
(see Getting Started for details). The selected file must be of an image
file format that TruePaint recognises (see Appendix B). If it is unable
to determine the format of the file, TruePaint will ask you to choose
the correct format as it does for Open As. This is not usually necessary
for files saved with the appropriate three letter extension. You may
also be asked to swap disks so that TruePaint can load one of its
External File Managers.

A progress bar will appear, showing you how much of the file remains
to be read. If there is a problem loading the file, the error will be
reported and youcan click on OK to continue. This can happen when
there is insufficient memory to open the image, in which case try
closing down some windows first.

Note that TruePaint will attempt to adjust the image or palette to suit
the current screen mode. This can cause some loss of quality which is
why it is always a good idea to keep pictures from different video
modes separate. You can change video mode using the Desktop.
TruePaint may also exchage the second colour in the palette with
anotheér to ensure that the screen display is readable. Although any
picture can be loaded in True Colour, palette modes must have a
sufficient number of colours to be able load the picture.
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Open As

Close

Open As is very similar to Open except that it allows you to choose
which EFM is to be used when loading the picture. Although it is
generally more convenient to use Open for loading images or
animations, Open As can be useful in a number of situations:

If you already know the format of a file, Open As can be faster,
especially if an EFM which is not currently loaded is required,
since this saves TruePaint from having to search through all of the
available EFMs to find the correct one.

TruePaint is unable to recognise certain file formats when non-
standard file name extensions are used (as‘is sometimes the case
with Targa files). Again, Open As is significantly faster than Open
in these cases.

Some files (notably IFF files) may contain more than simply a
picture. To load an image which forms part of a more complex
document you can use Open As.

Upon choosing Open As from the menu, a dialog box similar to the
Save As Options will appear. You can either double-click on the
required file format or click once and press OK to proceed. Using the
file selector you should then select the file to be opened in the normal
way. Selecting Cancel at any stage will abandon.

Control W

Close has exactly the same effect as closing the current image window

“with the mouse. If you have changed the picture in any way since it

was opened or created, TruePaint will ask you if you wish to save the
updated version to disk before closing the window, otherwise it will
just close the window immediately.

Warning: you cannot get back a picture that has been
changed and then closed without saving!

TruePaint
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Control S

The Save option allows you to store the current image or animation on
disk. Selecting it will do one of two things. For untitled windows, Save
automatically does a Save As so that you can select a name and file
format for the picture. Otherwise it will save the picture to disk over
the existing version. If you do not wish to do this, or want to save the
image in a different file format, use Save As instead.

For a complete description of how to save your work to disk, please
refer to the Getting Started section.

Save As

Save As allows you to save a picture of animation to disk with a choice
of file formats and name. This would normally be used to save
different versions of a picture, or/perhaps an individual frame out of
an animation. Selecting Save on an untitled image has the same
effect. First of all, a dialog box similar to the File Format Options
appears, showing all of the available file formats.

File Format:

Inc. GIF(sm)

[Cancel | [ ]

the Save As Options dialog
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Either double-click on the required format or select it and press OK or
Return to continue. The arrow buttons move through the list of file
formats, those marked with a tick are currently resident in memory
(see the File Formats menu option for details). Closing the dialog or
selecting Cancel will abandon the save. You might want to use the TPI
and TPA formats for speed, or if there is insufficient memory to load
an EFM, since these are built-in.

Not every format is capable of representing any picture and most of
them only save single images rather than animations. It is up to you to
choose an appropriate file format, TruePaint will tell you if it is
unsuitable for the picture. Details of the various formats can be found
in Appendix B.

After choosing a format, a file selector will appear for you to give the
file a name and choose where it is to be saved. Leaving the file
extension (i.e. the three letters after the dot) blank will ensure that
TruePaint substitutes the correct extension. Adding your own may
affect TruePaint’s loading of the file. A progress bar will appear
during saving, indicating how the save is progressing. See the Save
option and Saving Your Work in'Getting Started for further details.

Revert

This allows you return to the last version of an image which was saved.
After asking you for confirmation, Revert reloads the picture in the
current window from disk, losing any modifications made since the
file was last loaded or saved. Note that you could Open the same
picture in a different window instead, although this can be confusing.

* You cannot Revert an untitled picture which has never been saved.

Revert can be used as a sort of mass undo. If you save your work
regularly or at various important stages (a wise idea anyway) and later
decide you have made a mistake, you can use Revert to go back to the
previous version instead of scrapping the whole thing and starting
again. You can also Undo a Revert to restore the changes or compare
two versions of a picture.
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File Formats

Selecting this menu item brings up the File Format Options dialog
which allows you to control which External File Managers (EFMs) are
kept in memory for fast access.

File Format:

i .gés?‘g:o. Inc. GIF(sm)
v isi GA™)
CuYasa o e fIS o rmat (TIFE) X
S

the File Format Options dialog

An EFM is a special program loaded from disk which understands
how to load and save a particular file format. They are normally
located inthe EFMS folder of your TruePaint disk and are loaded
automatically as required. Although this saves memory, it can be slow
since every time it loads or saves an image, TruePaint must first load
the relevant file manager.

Using the File Format Options you can select those formats you use
most often to be permanently loaded for speed. Save Setup will
remember these so that they are loaded automatically when you start
TruePaint. However, it is not usually a good idea to have all of the
EFMs loaded since each one takes up memory; others will still be
loaded from disk as before.

Note: cut-down versions of the TPI and TPA file managers are
built into TruePaint to ensure that you can always save your
work if you run out of memory. Their disk loaded equivalents
are only required for loading pictures created in a different
screen mode.
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Formats

Folder

Quit

You can choose whether an EFM remains in memory by simply
clicking on it in the file format list. A tick appears beside those that
are loaded. Closing the dialog, clicking on OK or pressing Return will
either read the extra EFMs from disk or unload those which you have
deselected. You can use this to reclaim memory if necessary.

The arrow buttons scroll through the list of available file formats and
clicking on Cancel will ignore any changes and close the dialog.

Although file managers are normally loaded from the EFMS folder on
your TruePaint disk, you can change this by clicking on the Folder
button. This produces a file selector which allows you to select a new
folder. Clicking on OK scans the selected folder for EFMs and
updates the list of file formats, Cancel will leave everything as it was.
Note that all of the EFMs must be ‘within the same folder.

Control Q

Select Quit to leave TruePaint and return to the Desktop. This will
automatically close all of the windows, asking if you want to save those
pictures which have been changed first before quitting. If you are
using a multitasking operating system then you can switch to the
Desktop or any other program without quitting TruePaint via the
Desk menu. To close only a single window, use Close.

Warning: any changes you have made to pictures will be lost
when you quit TruePaint unless you save them!
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The Edit Menu

Edit menu options work with whole sections of the image and the clipboard.
Several of these only become available once an area has been selected, using
the Selection tool for example.

Undo

Cut

Undo AL
Cut AX
Copy AC
Paste A

e snt dwe o ot son ave vee ot ot o e o ot o 0 e o e o)

Select Visible AR
the Edit menu

The clipboard is the place wheré an area that has been ‘cut’ from an
image is kept, ready for ‘pasting’ (see the Cut and Paste tutorial for
details). There is only one clipboard and it can be used to transfer
graphics between windows. The contents of the clipboard are lost
when you quit TruePaint.

Undo or Control Z

This option will literally un-do changes made to the picture, allowing
you to correct a mistake or accidental modification. It remembers
everything that was changed since you last moved off the drawing
area, so Undo may remove one or more changes at once.

Selecting Undo a second time will restore the picture. You can use
this to switch between the modified and unmodified versions for
comparison. Pressing the Undo key has exactly the same effect as
selecting this menu item.

Control X

Cut removes the selected area from the picture and places it in the
clipboard. The selection is cleared to the background colour and the
previous contents of the clipboard are lost. This can be used to move
part of an image from one place to another since the cut section may
subsequently be pasted elsewhere.
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Copy

Paste

This is exactly the same as using Copy followed by Delete. Part of the
image must have been selected with the Selection tool or Select
Visible menu item in order to use this option.

Control C

This simply copies the selection into the clipboard ready for pasting.
The previous contents of the clipboard are lost although, unlike Cut,
the image itself is left unchanged, so this can be used to duplicate
part of an image. Copy is only available after selecting an area with
Select Visible or the Selection tool.

Control V

Paste is used to draw the clipboard image from the most recent Cut or
Copy operation on the current picture. It cannot be selected when the
clipboard is empty. See the Cuf and Paste tutorial for a full
explanation of these options.

Choosing Paste activates the Selection tool and causes the contents of
the clipboard to appear within the current window in a rectangular
box. To position it, hold down the left mouse button with the pointer
inside this box and drag it t0 a new position. You can do this any
number of times. Double-clicking will actually draw the clipping onto
the image, clicking outside the box will cancel.

The results of a Paste are determined by the current Write Mode in
General Options. This may be used to paste a partially transparent
image with areas of the background showing through, or to mask one
image with another. By default, the pasted section completely
overwrites the underlying image.

You can choose Paste several times in a row to paste multiple copies
since Paste does not empty the clipboard. It is also possible to select
an Effects menu item to manipulate the pasted area before drawing it
onto the picture if you wish.
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Delete

Select

Delete

Delete will either clear the selected area to the background colour or,
if there is no selected area, ask if you wish to erase the entire image. It
does not place the deleted area in the clipboard, so if you wish to
paste it somewhere else, use Cut instead. The only way of restoring a
deleted area is to Undo.

Although Delete can be used to start a new drawing, it is usually
better to use New instead since it creates a new window. Otherwise,
you might accidentally save the new picture to disk over the old one.

Visible Control A

This menu option will select all of the image that is visible in the
current window. Although this is not useful for limiting the drawing
area, it can be used for Cut, Copy or any of the Effects menu options.
From Full Screen mode, using the Keyboard shortcut will select the
entire screen area. To select other sized areas, use the Selection tool.

The View Menu

The View

menu only affects the TruePaint window display; none of these options

actually modify the image’ itself. Other related options can be found on the
General Options dialog.

Full Screen [Clrl
Zoon [Z1
Animate M1
Co-ordinates ©I
Snap to GOrid &N

Overscan O]
6rid... ®6
Ruler... ¥R

the View menu
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Full Screen Clr Home

Zoom

This is a very useful facility which switches TruePaint between window
mode and Full Screen mode, where the whole display is used for
drawing. Although you can only view a single image, the larger
drawing area often makes working on the picture much easier. It can
also be useful for checking that frames of an animation line up
correctly.

All of the drawing tools and many menu options can still be activated
via their keyboard shortcuts in Full Screen mode although it is not
possible to access dialog boxes. You can scroll around the image
using the cursor keys or by moving the mouse whilst holding down
both the Alternate key and left mouse button as normal. To exit Full
Screen mode, press the Clr Home key or Esc.

If your computer and monitor support overscan then you can make
use of it for the Full Screen display by selecting the Overscan option
before entering Full Screen mode.

¥ 4

This menu item is used to.switch Zoom mode on and off. Zoom mode
magnifies part of the image, allowing individual pixels to be edited.
This may be used in conjunction with Full Screen mode. If the
Selection tool has/been used to select an area, Zoom will magnify this.

When Zoom mode is on, indicated by a tick next to the menu item,
the toolbox display will change.

the Zoom mode tools

Although it is not possible to use all of the regular drawing tools, as
you can with the Hot Spot display, there are a number of special tools
available for detailed editing in Zoom mode. These also have
keyboard shortcuts.
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L - [+ | # | pot size 123

Three different dot sizes are supported for drawing. With one of these
active, clicking over the image will draw dots of the selected pen
colour (like using the Dots tool). Simply click on one of the icons or
press a number key between 1 to 3 to select a dot size.

Fill F

Similar to the normal Fill drawing tool, clicking on the image with this
icon selected will flood a single colour area with the current pen
colour. It does not use fill patterns.

Zoom In +

Clicking on this icon will increase the magnification, making each
pixel appear larger for more detailed editing, although less of the
image will fit in the window. You may wish to use the numeric keypad
for this tool’s keyboard shortcut.

IE Zoom Out -

Zooming out decreases the magnification level so that more of the
picture can be seen and the pixels appear smaller. To zoom out
completely and return to actual size you must select Zoom from the
menu once more.

Colour

Most of the Zoom mode toolbox is taken up by a colour palette
similar to the Palette toolbox display. This consists of either coloured
boxes or-a colour wheel in True Colour mode which you can use in the
normal way to change the pen colour for drawing or filling.

Animate M

This is used to enter Animate mode for replaying animations over the
whole screen (not to be confused with Animation on the Options
menu which allows you to edit the animation). Upon selecting it, the
display will show the first frame in the sequence and a number of
icons used to control playback. For a description of these, please refer
to the Animation chapter. Note that there must be more than one
frame in the sequence to Animate.
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You may play animations in overscan mode if your computer
supports it by selecting Overscan from the View menu before
entering Animate mode.

Co-ordinates Alternate |

Co-ordinates is a switchable menu item. With it selected, the exact
pixel position of the mouse pointer over the image is shown above the
toolbox to help with accurate mouse positioning as you move around
the drawing area. For example, you could draw concentric circles by
using the Co-ordinate display to ensure that each circle has exactly
the same centre point.

All co-ordinates are relative to the origin and match those shown on
the Ruler display. The X co-ordinate is the number of pixels across the
image and the Y co-ordinate is the number of pixels down with
negative numbers indicating positions to the left of or above the
origin. The Ruler display and General Options dialog can be used to
adjust the origin.

Snap to Grid Alternate N

When Snap to Grid is on (indicated by a tick next to the menu item),
all drawing is restricted to the grid lines set up in Grid Overlay
Options. This affects all drawing tools and the placement and sizing of
selected areas. Selecting the menu item switches Snap to Grid on or
off.

This facility can be useful for a number of things such as accurately
aligning different elements of a picture, ensuring smooth and even
movement in an animation, constructing an image out of smaller
blocks and drawing lines at specific angles.

Overscan Alternate V

Overscan is only available when running on a Falcon computer with a
non-VGA monitor and allows graphics to be displayed over a larger
area of the screen than usual (see the Background section). This
option determines whether overscan is used in Full Screen and
Animate modes. It has no effect on the normal TruePaint window
display.
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Grid

Note that if your computer was already in overscan mode when
TruePaint started up, this option will have the reverse effect.

Since overscan increases the dimensions of the display area
and is intended for video work, it is normal for the edges of the
picture to be hidden from view by the monitor.

Alternate G

Selecting Grid from the View menu will reveal the Grid Overlay
Options dialog described below. This may be used to temporarily
overlay a grid on the drawing area. Double-clicking on the Grid
drawing tool icon has the same effect.

A grid can be an excellent drawing aid for copying pictures from
paper to the computer screen. By. placing ‘a corresponding grid over
both pictures you can copy each/square individually, making it much
easier to avoid distorting the picture. You can enlarge or reduce the
picture while copying by simply varying the size of the grid squares.

There are two ways of doing this-in TruePaint. You can either draw a
grid in the window with the Grid tool and draw over it as you create the
picture, or you can overlay a.grid. This has the advantage that it can
be switched off or on later at will.

Grid Overlay Options

The Grid Overlay Options dialog can be accessed via Grid on the
View menu or by double-clicking the Grid drawing tool. It allows you
to supérimpose a grid over the image and adjust the size of the actual
grid squares.

[] G6rid Overlay On/0ff

X Scale: 32
Y Scale: 3IZ_

the Grid Overlay Options dialog

Page 122

Reference TruePaint



Click on OK, close the dialog or press Return to use the new options
or click on Cancel to ignore any changes. Note that these options
apply to all windows.

Grid Overlay On/Off

The overlaid grid may be switched on or off for all windows by clicking
in this box.

X and Y Scale

Ruler

These sizes determine the pixel dimensions of a single grid square for
both grid overlays and Snap to Grid. They may be altered by clicking
on the appropriate number and using the keyboard to enter the new
size with Backspace to rub out. You may wish to use the Ruler display
to determine appropriate grid sizes.

Alternate R

The TruePaint rulers are bars numbered in pixels that appear above
and to the left of the drawing area. These numbers correspond to
those given by the Co-ordinates display and may be used to assist
accurate positioning and measuring with the mouse pointer.
Selecting Ruler from the menu will reveal the Ruler Options dialog
box.

The pixel position wheré both rulers show zero is called the origin.
Depending upon the settings in the General Options dialog, this may
be the top left of the image or some other location, defaulting to the
exact centre of the picture. This user origin is indicated on each ruler
by a small arrow marker. Points before or above the origin have
negative co-ordinates.

To set the user origin from the ruler display, hold the mouse button
down over the box where the rulers meet (next to the Pattern icon)
and drag the pointer onto the image. The arrow markers will move
with the mouse and remain wherever you release the mouse button.
The origin can also be changed from General Options.
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Ruler Options

The Ruler Options dialog is obtained by selecting Ruler on the View
menu. It is used to switch the ruler display on or off and to change the
intervals at which co-ordinates are marked on each ruler.

(] Ruler On/0ff

X Interval: 32[.
Y Interval: 3Z.

the Ruler Options dialog

To accept the new settings press OK, Return or close the dialog.
Cancel will ignore any changes and Apply will update the display with
the new settings. You can set up separate rulers for each window if you
wish.

Ruler On/Off

To switch the ruler display on or off, click in this box. The box will be
filled if rulers are selected.

X and Y Interval

The size of the interval between each mark on the rulers is controlled
by these options. Note that this does not change the actual co-
ordinates, just the quantity of co-ordinates shown on each ruler. X
Interval affects the ruler along the top whilst Y Interval is for the ruler
at the side.

To change the intervals, click on the number and use Backspace
followed by the number keys to enter a new value. Smaller numbers
will show more co-ordinate positions on the ruler.
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The Options Menu

The Options menu, shortened to Opts in low resolution, contains many settings
which allow you to configure TruePaint and the actions of various drawing tools.
Most of the items on this menu either produce a dialog box or switch a
particular feature on or off.

v Free Form ®E

v Filled Shapes ©F
Rounded Boxes ©B
Rainbow W

General... 0]

Colour... ®C

Shadow., .. EH

Animation... ©A

e e e e o e s e e s o o g o st e g

Save Setup

the Options menu

Free Form Alternate E

Free Form affects all of the shape drawing tools including Circle,
Rectangle and Polygon, and may be turned on or off by selecting this
menu item. By default, Free Form is on, so you can draw shapes of
any size and proportion. With Free Form off however, TruePaint will
automatically match the width and height of shapes, allowing you to
draw perfect circles, squares etc. (although this will depend upon your
display). Non-regular polygons are not affected.

Filled Shapes Alternate F

With Filled Shapes switched on (indicated by a tick in the menu), the
various shape drawing tools such as Circle, Rectangle and Polygon
create solid shapes rather than outlines. Shapes are filled in the
selected fill pattern using either the current pen colour or Rainbow
mode if selected.
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Rounded Boxes Alternate B

Selecting Rounded Boxes will cause all rectangles and squares drawn
with the Rectangle tool to have rounded corners, giving a ‘speech
bubble’ effect. Note that Rainbow mode cannot be used with
Rounded Boxes unless they are filled.

Rainbow Alternate W

In Rainbow mode, TruePaint draws lines and shapes in a series of
colours instead of the current pen colour. The start and end colours
can be set up using the Colour Options dialog. You can switch this
feature on or off by selecting this menu item.

In True Colour mode, the rainbow colours will be graduated smoothly
from the selected Rainbow 1 colour to Rainbow 2 in the specified
number of steps. In palette modes, the colours appear in their palette
order. See the Colour tutorial and individual drawing tools for details.

General Alternate O

Selecting this option brings up the General Options dialog used to set
up various drawing and view attributes.

A = U
Write Mode: Mirror:
Replace None
Transparent Horizontal
XOR Vertical
Stencil Diagonal
4-Way
Origin:
E Top Left Hot Spot:
User 0ff
:0383 1]“8239 'l'on
| Side
| Segmente
-~ -5~~~ 1 Width: 3@
| Height: 1Z_
| Zoom: 4_

the General Options dialog
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After changing some of these options you can either click on OK,
press Return or close the dialog to accept the changes or, as usual,
click on Cancel to ignore all changes and close the dialog. Apply will
use the new options without closing the dialog.

Write Mode

Origin

The Write Mode affects all of the drawing tools, the Effects and the
Paste command. There are four different Write Modes, each of which
causes drawing to affect the image in a different way. They can be
selected by clicking inside the appropriate box, the current Write
Mode will be highlighted. See the Tutorials for some examples of their
use.

By default, TruePaint uses Replace mode which means that any
drawing completely overwrites the background area and patterns are
drawn with a fixed colour background. When Transparent mode is
used, the background colour becomes transparent so that the
underlying picture shows through. This is ideal for adding text and
pasting images.

XOR is a special effect that combines the drawing colours with the
image so that anything drawn twice will disappear. It can be used to
create unusual textures and photographic negative effects in True
Colour mode. Stencil causes only the background colour to be drawn,
all other colours appear transparent. This can be used to ‘mask out’
parts of an image-and create textured or coloured text.

This is the position on the image where both X and Y co-ordinates are
zero (see the Co-ordinates and Ruler options), also used by the Mirror
options/ The origin may either be fixed at the top left corner of the
image or set to any other position by clicking on the Top Left or User
box.

To adjust the user origin, hold the left mouse button down over the
image at the bottom left of the dialog box. By moving the pointer to
the edges of the image so that it scrolls, position the image so that the
crosshairs lie over the desired origin. Releasing the mouse button will
set the origin. You can also do this from the Ruler display. Note that
the user origin is ignored when Top Left is selected.
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Mirror

TruePaint has the ability to ‘mirror’ all drawing through the user
origin to produce kaleidoscopic effects or symmetrical drawings. The
four different mirror options each reflect drawing in different ways.
Horizontal and Vertical mirror in a single direction, Diagonal mirrors
through the origin and 4-Way is a combination of all three which
draws everything four times. Select None to switch mirroring off.

Note that, as with all other drawing, only the visible part of the image
or selection can be drawn into using the mirror options so you may
wish to use Full Screen mode. To change where drawing is reflected,
adjust the user origin.

Hot Spot

An alternative to Zoom mode, the Hot Spot display not only allows
detailed editing and accurate positioning of the mouse but gives you
use of all the normal drawing tools too. The Hot Spot is a magnified
representation of the area immediately surrounding the mouse
pointer. It may be placed above'or to the side of the drawing area and
can be of any size, although larger sizes will slow down the display.

To switch on the Hot Spot, click in the Top or Side box. Segmented
outlines each magnified pixel with a box whilst Width and Height set
the dimensions of the Hot Spot display. Sizes that extend past the
edge of the drawing area will be ignored.

Zoom allows you to adjust the magnification of the Hot Spot display.
Increasing the number will make the pixels appear larger but reduce
the size of area that can be displayed. To change these numbers, click
on them with the mouse and enter a new value from the keyboard
using Backspace to rub out.

Colour Alternate C

Selecting Colour from the Options menu or double-clicking on the
Pen Colour indicator or a palette colour will reveal the Colour Options
dialog used to modify the palette, to set the two rainbow colours and
to adjust the pen colour.

There are two variations on this dialog which appear, depending upon
whether you are running in a palette-based or True Colour mode. The
palette mode dialog includes additional facilities for changing an
image’s colour palette. For further details, see the Colour tutorial and
Background section.

Page 128 Reference TruePaint



Colours

| Pen .(:ulour
= E Rtz
[Spread || Default | Restore || OK

the Colour Options dialog in 256 colours

After making the required changes you can click on OK, close the
window or press Return to continue. Note that you can also use the
Palette toolbox display or Pick Colour tool to select the pen colour.

To choose a calour; click on the palette or colour wheel display. This
will change either the pen colour, Rainbow 1 or Rainbow 2, depending
upon which of these boxes is active. The Red, Green and Blue sliders
will be updated to reflect the colour you chose and can be used to
adjust the colour or to change the palette.

Red, Green and Blue

These three sliders represent the mix of primary colours that make
up the selected colour. In True Colour mode they are simply an
alternative method of selecting colours to the colour wheel, but in
palette-based modes they actually modify the picture’s palette. See
the Background section and Tutorials for an explanation of RGB
colour and colour palettes.

There are three ways of adjusting the slider levels: dragging the
indicator to a new position whilst holding down the mouse button,
clicking on the patterned background for fast adjustment, and
clicking on the arrows for fine control.
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Although the sliders range from zero to one thousand, each step does
not necessarily represent a different colour due to the limited
number of levels which the computer can display (8 on the ST, 16 for
the STe or TT and 256 on the Falcon030). However, TruePaint will save
this information with the file where possible which may affect the
colours displayed on a different machine.

Note also that finer colour resolution is available in Falcon palette
modes than in True Colour mode - although you may not always be
able to tell the difference!

Rainbow Step

This is a True Colour option which determines the smoothness of the
rainbow effect by setting the number of steps in which the colour
transformation takes place. The individual steps become visible if
small numbers are used whereas large numbers take longer to draw
but give a smoother rainbow effect. Simply click on the number and
use Backspace and the number keys to enter a new value.

Rainbow 1 and 2

Clicking on the Rainbow 1 box or the Rainbow 2 box causes any colour
selection to alter one of the Rainbow colours instead of the pen
colour. Subsequent use of the Pick Colour tool will also change the
selected Rainbow colour, useful for picking the Rainbow 1 Range for
the Brush tool.

The coloured bars at the bottom left of the dialog show the two
Rainbow ¢olours and a sample Rainbow display. For a full explanation
of Rainbow mode, see the Colour tutorial and the Rainbow menu
option.

Pen Colour

When this box is selected, clicking on the palette or colour wheel will
change the current drawing pen colour in the same way as the Palette
display. This is also useful if you wish to alter the colour palette
without affecting Rainbow mode.
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Spread

Default

For palette modes only, Spread creates a smooth colour range
between the selected Rainbow 1 and Rainbow 2 colours. Although it
does not alter either Rainbow colour, all of the palette colours in
between will be changed to intermediate shades. This is useful for
adding a range of similar colours to your palette, or for smooth
Rainbow mode effects.

and Restore

The Default button resets the entire palette to the standard set of
colours. These will either be the system default colours or those
previously stored with the Save Setup option. Clicking on Restore
cancels all changes made to the palette since the Colour Options
dialog appeared.

Load and Save

You can store colour palettes on disk using the Load and Save buttons
of the Colour Options dialog./It is possible to Save one picture’s
palette and Load it into another as a way of copying the palette from
one window to another. Clicking on either button produces a file
selector for you to choose a palette file from disk. It is recommended
that you give palette files an extension of .PAL and keep them in a
separate folder. TruePaint palette files are not generally compatible
with those of other programs.

TruePaint can also load the palette directly from an existing picture if
you select it from the file selector. This is a good way of ensuring that
the two palettes are an exact match. Note that, to ensure the screen
display is readable, TruePaint may exchange the second colour in the
palette with another when loading, as it does with picture files.
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Shadow Alternate S

Colour

Shadow brings up the Shadow Options dialog which allows you to set
the colour, direction and depth of shadows drawn beneath shapes
and lines. Most of the drawing tools will use shadows if they are
selected.

% | Shadow Options
Colour: [ | Direction:

Distance: 16/

[ Cancel | | fpply | |[_OK

the True Colour Shadow Options dialog

After using the dialog to change the shadow options you can press
Return, click on OK or close the dialog to accept the new settings.
Cancel will restore them to their previous state and Apply will use the
new settings without closing the dialog box.

The colour of the shadow may be altered by selecting a colour from
the palette display or the colour wheel on the Shadow Options dialog.
By default it is black but it may be set to any colour.

Direction

Any of nine shadow directions can be selected by clicking on the
appropriate box which will become highlighted to show that it is
active. The shadow effect is usually more convincing if you ensure
that all the shadows in the picture fall in the same direction. The
centre box switches shadows off, which is the default setting.
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Distance

This is the gap between the actual drawing and its shadow. Visually,
this affects the ‘height’ of drawn objects since the proximity of the
shadow usually indicates how close an object is to the background.
You may wish to vary the distance used across the picture.

To change the distance, click on the number with the mouse and
enter a new value from the keyboard using Esc or Backspace to rub
out. Larger numbers give a more distant shadow.

Animation Alternate A

Selecting this option will present you with the Animation Options
dialog which gives access to TruePaint’s animation editing facilities.
There is a separate chapter devoted to animation which gives a
detailed explanation of these options along with some background
information and useful techniques that you can use in your own
animations. In brief, the options are as follows:

Frame is the frame number in the sequence to add, delete or view.
You can type a number and click.on Apply or OK to show this frame
in the window. Length of Sequence gives the number of the last
animation frame.

New Frame After and New Frame at End insert an extra frame in the
sequence by duplicating either the frame with the given frame
number or the very last frame. The sequence length will increase by
one unless_there is insufficient memory available. Remove Frame
deletes the frame from the sequence.

You can also select Animate from the View menu to take you into
Animaté mode where you can replay the animation at various speeds.
For further details, please refer to the Animation section.

Save Setup

Save Setup stores the current settings on disk, including Tool
Attributes, menu options, file formats, the default palette and all the
patterns. This can be used to remember all of your preferred settings
so that you don’t have to change them every time you run TruePaint.

The setup is saved in the TRUPAINT.INF file which is loaded
automatically when you start TruePaint. Note that selecting this will
overwrite any previous settings file.
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The Effects Menu

The Effects menu provides various transformation effects which work on the
selected area or during a Paste. Many of these can be used in conjunction with
one another or several times in succession before drawing the results onto the
picture. See the Effects tutorial for details.

H-Flip
U-Flip

e s s e e s e o e e e |

Resize
Stretch
Pattern
H-Shear
U-Shear
H-Wrinkle
U-Wrinkle

the Effects menu

Although each effect is different, their operation is very similar.

. Either select an area with the Selection tool or the Select Visible
menu item, or Paste the contents of the clipboard.

. Choose the desired effect from the Effects menu. Unless the effect
takes place immediately, a tick will appear next to the menu item
to show that it is active.

. Using the handles which appear, adjust the box to the required
dimensions. To reposition the entire selection, click and drag the
boxitself.

. Double-click the left mouse button over the drawing area to draw

the result onto the image or click outside the selection to cancel.
Alternatively, you can choose another effect.

H-Flip

Horizontal Flip gives the effect of viewing the image in a mirror.
Unlike most of the other effects, it takes place immediately and works
on the entire picture if there is no selected area. H-Flip may be used
in conjunction with other effects and selecting it twice will return you
to the original image.
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V-Flip

Resize

Vertical Flip mirrors the image vertically. Like H-Flip, it happens
immediately and can be used on the whole picture or with other
effects. Note that this is different to turning the image upside down.
To do this you must use both H-Flip and V-Flip.

Resize changes the size of the selected image, ensuring that it retains
its original proportions. This is similar to Stretch except that the image
cannot be distorted, only increased and decreased in size (although
quality may still be lost). In general, it is best to draw the original
image at its maximum size and scale it down.

With Resize and Stretch you can adjust the size of the image with the
selection handles any number of times. However, choosing the effect
a second time will lose quality. This will create a mosaic effect if you
first reduce the image in size and then select Resize again to restore it
to its original size. \

Stretch

This allows you to adjust both dimensions of the selected image to
make it larger or.smaller. It differs from Resize in that the correct
proportions are not necessarily retained. As discussed in the
Background section on fonts, scaling in this way can lose detail or
produce blocky pixel effects.

Pattern

This effect ‘tiles’ the selected area to produce a repeating pattern or
texture. Note that you must increase the size of the selection using
the handles to achieve the pattern effect, otherwise the image will
simply be trimmed down to size. You may want to Resize the selected
image first.
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H- and V-Shear

The Shear effects skew the image in a given direction. Horizontal
Shear gives an effect similar to italics whilst Vertical Shear draws the
image on an upward slope. In each case, the selection handles adjust
the skew angle and are restricted to moving in a single direction only.
It is not possible to apply further effects after shearing,.

H- and V-Wrinkle

These effects repeatedly shear the image back and forth in a zigzag
pattern. Horizontal Wrinkle bends the image from left to right whilst
Vertical Wrinkle can be used to simulate waves. The placement of
the handles determine the length and depth of a single ‘wrinkle’
which is then repeated over the entire length of the image.
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Appendix A

Keyboard Shortcuts

This Appendix contains all of the TruePaint menu and toolbox key equivalents.
Zoom and Animate mode shortcuts are listed last. Not all keyboard shortcuts
are available at all times - see the relevant chapters for details:

File Menu

New
Open
Close
Save

Quit

Edit Menu

Undo
Cut
Copy
Paste
Delete

Select Visible

Scrolling

Scroll Left
Scroll Right
Scroll Up
Scroll Down
Page Left
Page Right
Page Up
Page Down
Drag Screen

Control N
Control O
Control W
Control S
Control Q

Control Z or Undo
Control X

Control C

Control V

Delete

Control A

=t 9

Shift «
Shift —
Shift t
Shift |
Alternate drag
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Drawing Tools

Airbrush A
Arc X
Brush B
Circle @
Connected Lines N
Curve V
Dots D
Fill F
Grid G
Line L
Pen (default) P
Pick Colour |
Polygon @)
Rays Y
Rectangle R
Segment E
Selection S
Text i
Tool Attributes
Airbrush Attributes Shift A
Brush Attributes Shift B
Define Fill Pattern Shift F
Dot Attributes Shift D
Line Attributes Shift L
Polygon Attributes Shift O
Text Attributes Shift T
Options
Animation Options Alternate A
Co-ordinates Alternate |
Colour Options Alternate C
Filled Shapes Alternate F
Free Form Alternate E
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(continued)

General Options
Grid Overlay Options
Overscan

Rainbow

Rounded Boxes
Ruler Options
Shadow Options
Snap to Grid

Miscellaneous

Drawing tools Display

Palette Display

Pattern Display

About TruePaint

Full Screen

Zoom

Animate

Next Frame (may require Shift)
Previous Frame (may require Shift)

Zoom Mode Shortcuts

Dot Sizes
Fill

Zoom In
Zoom Qut

Animate Mode Shortcuts

Play

Increase Delay
Decrease Delay
Ping-Pong

Exit

Alternate O
Alternate G
Alternate V
Alternate W
Alternate B
Alternate R
Alternate S
Alternate N

Help
Clr Home

J‘\Vg[\]

123

Return

Esc

Keyboard Shortcuts
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Appendix B
File Formats

This Appendix contains details of some of the file formats available” from

TruePaint,
extensions.

their uses, portability, capabilities and their standard file name
There may well be additional formats which we ‘have implemented

since writing this manual for which you should refer to the READEFMS.ME file

on disk 1.

Introduction

Unlike many traditional image manipulation programs, TruePaint
uses an External File Management System (EFMS) to handle the
loading and saving of images: External File Managers (EFMs) are
special programs that understand how to load and/or save a
particular image file format. This not only gives you the ability to work
with pictures from a wide variety of sources but it also allows efficient
memory usage since you only need load the particular EFMs that you
will be using in the current session.

For any particular file format, the pictures which may be saved using
it can differ greatly, For example, TIFF may be used to save any
picture which TruePaint can generate, whereas NEOchrome is
restricted to pictures which exactly match the specifications of ST low,
ST medium and ST high resolution (320x200x16 colours, 640x200x4
colours, 640x400x2 colours). The purpose of this Appendix is to
describe the various EFMs that are supplied with TruePaint and to
point out any restrictions within the various file formats that you
should be aware of.

When TruePaint loads an image, it attempts to convert it to the
current video mode, which may result in some loss of colour accuracy.
Subsequently saving the file may cause it to be written out in such a
way that the program that originally created the image will be unable
to load it back in, the most extreme case being saving a monochrome
image in True Colour mode.
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Note that, due to the extremely large number of file formats in use
and the difficulty in obtaining documentation on many of them, there
are many programs which write ‘broken’ files which TruePaint may
fail to load correctly. This may be because there is part of a file format
specification which we have not yet implemented; you should check
the READEFMS.ME file for known restrictions. If after checking this
you encounter such an image, please send us a copy of the file, telling
us what format you think it is and which other programs you know of
that load it correctly.

Image File Formats

Degas

GIF

.PI1-8, .PC1-8

Degas and Degas Elite were among the first of the third-party
graphics packages for the Atari. The image formats they support (PI1,
P12, PI3, PI5, PI7 and PI8 uncompressed and PC1, PC2 PC3, PC5, PC7
and PC8 compressed) allow all standard ST and TT screen modes to
be used: 320x200x16, 640x200x4, 640x400x2, 640x480x16, 1280x960x2 and
320x480x256.

This EFM is principally available for its use as an import filter,
i.e. for loading your old pictures. In general, this format is not
recommended as a method of saving your pictures since, even
if the picture will fit within the other constraints, a Degas
picture only has a resolution of 4096 colours cf. 262144
supported by Falcon030.

.G,F

The Graphics Interchange Format (GIF, pronounced ‘jif’) is a format
designed by CompuServe for the on-line transmission and
interchange of palette images and is probably the single most
successful ‘paint’-type image format, with many thousands of images
available on on-line services (indeed, many such images are available
on CD-ROM in collections such as GIFs Galore, containing over 6500
images).
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GIF is especially suitable for the import or export of images
containing up to 256 colours (there is no True Colour support in this
format) although, due to the complex compression algorithm used,
some loss of performance may be noticed.

We are required to state that:

“The Graphics Interchange Format(c) is the Copyright property of CompuServe
Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated.”

IFF ILBM .LBM

Image

The Interchange File Format (IFF) was devised by Electronic Arts®
for open file interchange of all forms of data (graphics, sound, text
etc.) across all platforms, although its use has been largely restricted
to Commodore’s Amiga® computer so much of this portability has
never been exploited. (there are some notable exceptions such as
Apple’s usage of it in their high' end system sound support) The
graphics portion of this standard is the ILBM (InterLeaved BitMap)
specification; many so-called IFF files are really IFF ILBM files.

Unfortunately for a portable file format specification, IFF ILBM files
contain several Amiga-specific artefacts which make its use on other
platforms difficult; in addition some programs write ‘broken’ IFF
ILBMs. You should refer to the READEFMS.ME file for details of
which display modes the TruePaint EFM supports.

Nevertheless, IFF ILBM files support all resolutions in palette modes,
in addition to True Colour files, although the True Colour
representations are not widely used. As a format for use in palette-
based work, IFF ILBM files are excellent. Note that you may need to
use Open As instead of Open to load complex IFF files which contain
embedded pictures.

MG

The GEM image file format was devised by Digital Research for use
with GEM. It supports all screen modes. IMG files are most useful for
exchanging images between applications on the Atari platform and
provide surprisingly effective compression ratios given the simplicity
of the method used.
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JFIF

Unfortunately, DRI failed to specify how the palette information was
stored or how a True Colour image could be saved. Several solutions
to the palette problem exist; these are known as NOSIG (archaic),
HYPERPAINT (produced by the HyperPaint® program), XIMG (the
German standard) and STTT. The best of these, XIMG, is used when
writing IMG files with the IMG EFM, all are recognised when reading,.
Files without any palette at all are interpreted as grey scale images.

The XIMG extension is also used for True Colour work; although files
saved from the Ventura 4 package can also be imported. Note that
not all programs recognise True Colour IMG files and some may
attempt to load them incorrectly.

JPG

JPEG (pronounced ‘jay-peg’, standing for Joint Photographic Experts
Group) is a standard compression method for compressing ‘real-
world’ pictures; cartoons and other non-realistic images are not its
forte. Also, JPEG is ‘lossy’, i.e. the output image is not necessarily the
same as the input image. However, on typical images of real-world
scenes, very good compression levels can be obtained without visible
change, and amazingly high compression levels are possible if you
can tolerate a low-quality image.

The JPEG File Interchange Format (JFIF) is a minimal file format
which enables JPEG bit streams to be exchanged between a wide
variety of platforms and applications. JFIF is suitable for all
resolutions and colour depths although, as noted above, JPEG does
not perform well on non-realistic images. Also the JPEG algorithm is
extremely numerically intensive, so load and save times are typically
very poor, although the level of compression possible is outstanding.

We are required to state that:

“this software is based in part on the work of the Independent JPEG Group”.
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NEOchrome .NEO

Targa

TIFF

NEOchrome was the original Atari paint program (circa 1985) which
ran only in ST low resolution. The file format it used, NEO, is capable
of storing 16, 4 and 2 colour pictures from a palette of 4096 at
resolutions of 320x200, 640x200 and 640x400.

This EFM is principally available for its use as an import filter,
i.e. for loading your old pictures. In general, this format is not
recommended as a method of saving your pictures since, even
if the picture fits within the other constraints, a NEOchrome
picture only has a resolution of 4096 colours cf. 262144
supported by Falcon030.

.TGA

The Truevision Targa (TGA™) format was developed by Truevision in
1984 for use in their true colour video cards and, as such, is one of the
most widely used true colour formats.

This format is extremely simple, but powerful, and provides support
for all video modes. For fast, portable True Colour image storage,
Targa is probably the best file format to use. For palette mode images
Targa is fine on-platform, but less transportable across platforms
since very few programs use the Targa format for palette-based work.

Note that you may need to use Open As instead of Open to load older
Targa files which do not use the .TGA extension.

.TIF

The Tag Image File Format (TIFF) is the de facto standard file format
for desktop images on all platforms. It includes support for images
from the simplest low-resolution monochrome picture through to very
high resolution YCbCr digital video. Because of this flexibility, the
TIFF specification (over 120 pages itself) is divided into two portions:
Baseline TIFF and TIFF extensions.

TruePaint implements all of the Baseline TIFF specification in
addition to many of the TIFF extensions; for those supported by
TruePaint you should refer to the READEFMS.ME file. When writing
TIFF files, TruePaint normally only uses Baseline TIFF features so
that the images should be readable by any other Baseline TIFF
reader.
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TIFF is the recommended file format for file interchange and final
storage since it is capable of representing all aspects of an image,
ensuring that no information is lost in the storage/retrieval process.
Unfortunately, the complexity of TIFF tends to handicap its
performance in some areas. This also means that the TIFF EFM is
considerably larger than many of the others.

The TIFF EFM is based, in part, on the work of Sam Leffler in his
public domain TIFF support software. We are required to state that
portions of this work are: '

“Copyright (c) 1988, 1989, 1990, 1991, 1992 Sam Leffler
Copyright (c) 1991, 1992 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for
any purpose is hereby granted without fee, provided that (i) the above copyright notices and
this permission notice appear in all copies of the software and related documentation, and
(ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written permission of Sam
Leffler and Silicon Graphics. 5

THE SOFTWARE IS PROVIDED "AS-1S" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEEELER OR'SILICON GRAPHICS BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT|OR CONSEQUENTIAL DAMAGES OF ANY
KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA
OR PROFITS, WHETHER QR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.”

TruePaint Image .TPI

The TruePaint Image format exists to provide a high speed load and
save mechanism whilst preparing an image. We do not recommend
that you use this format as a final archive format - for that you should
use one of the more compact, portable formats (GIF, IFF ILBM or
TIFF for palette images; Targa, TIFF or JFIF for True Colour images).
TPl files are also compatible with Prism Paint .PNT files.

This format is always available for saving since it is built into
TruePaint. Note that the high speed aspects of this format are lost if
you subsequently load an image into a different resolution from the
one in which it was created, requiring that it is converted to that video
mode. This action also requires the disk-based TPl EFM to be
available since conversion is not performed by the built-in EFM.
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TPI files saved on one machine will not necessarily load into
TruePaint running on another computer, due to differences in
the internal data representation, if a third-party video card is
being used. If in doubt, use one of the portable file formats
instead.

TruePaint File Formats Page 147



Animation File Formats

Like still image file formats, there are several (although considerably
fewer) animation formats in common use, but unfortunately these
differ considerably in the manner in which they work. In-the future we
hope to add support for other animation formats. However, at the
time of writing, the only format supported is TruePaint's own.

Note that attempting to save an animation using one of the still
image file formats will save only the current frame, not the entire
sequence.

TruePaint Animation .TPA

This is a proprietary format for full screen animations in all video
modes. For speed it uses the same method of storage as TruePaint
itself, so file size depends upon the differences between successive
frames in addition to image size and length of sequence. Since TPA
files can become very large, we recommend high density floppies or a
hard disk for storing animations.

As with TruePaint Image files, part of this EFM is built into the
program so you can always save your animations with it, even in low
memory conditions.
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EFMS Developers Kit

TruePaint is only the first of many HiSoft products to use the External
File Management System. In the future, products such as SBasePro4
and K-Spread 5 will add EFMS support.

The EFMS specification includes support for many different file types
(graphics, sound, animation, vector graphics etc.) which products may
call on. With the arrival of Falcon030 the range of capabilities of Atari
computers has been expanded greatly and many of the existing file
formats are no longer relevant, which is why we developed the EFMS.
This system is available for licensing by third parties. If you would like
details please contact David Link at HiSoft.
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Appendix C

Speedo and Font GDOS

To make the most of TruePaint’s text and curve drawing facilities you will
require the Speedo or Font GDOS software, available separately. We have
included some basic information on these packages here to explain how they

work.

What is GDOS?

GDOS is an extension of your operating system. When installed, it
allows the programs that you run to output text and graphics to
printers and other devices besides the screen. GDOS also enables
you to print text in many different font faces. Instead of typing
characters in the standard system font, you now have access to Swiss,
Times, Bitstream Charter and a multitude of other fonts. GDOS is run
when you first turn on your machine.

In addition, Speedo and Font GDOS (but not ‘old” GDOS) add other
features, not directly connected with text, such as Bézier curves and
several other low level operating system features.

Which version of GDOS?

All versions of GDOS support bitmap fonts, but both Font and Speedo
GDOS support a new feature: ‘font caching’. With old versions of
GDOS, every bitmap font that you wish use takes up memory, and
your machine will quickly run out of space. With font caching, you tell
Speedo/Font GDOS how much memory that you wish to devote to
storing your bitmap fonts. This memory is called a cache.
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Speedo/Font GDOS will load in the font as it's used. When there is no
longer any room for the next font, Speedo/Font GDOS will get rid of
one of the fonts to make room. As long as the memory that you
allocate is bigger than the largest font, Speedo/Font GDOS will be
able to use as many bitmap fonts as you wish in a limited amount of
space.

In addition to bitmap fonts, Speedo GDOS allows programs to print in
scalable outline fonts instead of bitmap fonts. Outline fonts offer
high-quality text at all sizes, whereas bitmap fonts.are limited to a
small number of sizes that become unappealing when crudely scaled
by the system. See the Background section for a more detailed
explanation.

Furthermore, unlike bitmap fonts, which are found in GDOS or Font
GDOS, outline fonts allow you to use the same font file to print any
size character on almost any output device. This is because the
description of the characters and not the character data is stored in
the font file. An ‘a’ for example is built using the same set of rules
whether it's built at 10 point or at 24 peint. This means you no longer
need a separate font for the different screen resolutions and, more
importantly, you no longer need separate fonts for your printers and
other devices. Speedo GDOS can create all of these characters for all
devices and all sizes using the same font description.

TruePaint works with.all current versions of GDOS, taking advantage
of whichever features are available in a particular version. If you can
obtain it, we would recommend that you use Speedo GDOS (although
it is not released at the time of the first publication of this manual);
failing that, try Font GDOS which is available from the ST-Club,
Nottingham.
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Appendix D
Technical Support

TruePaint comes with 30 days free technical support, starting from the date of
registration; therefore you should send in your registration card quickly.
Technical support is available by telephone during our Technical Support Hour,
by letter or by fax.

When contacting HiSoft for technical support, the following will save
time and help us give you a quick answer:

. Please ensure you have read the relevant sections of the manual
carefully and the READ.ME file before contacting us (many
problems are simple mistakes which could easily be avoided by
referring to the manual).

. Give us both the version number of the software from the About
TruePaint dialog box and your exact hardware configuration. We
will also need your disk 1 serial number.

. When telephoning, call while actually in front of your computer if
possible so that you can quickly try out suggestions. Alternatively,
have the manual to hand for reference.

Should you wish to receive extended technical support, please
complete the relevant sections on the registration card, indicating
whether you would like to take up the Silver or the Gold service.

In addition to your name, address and postcode (very important for
UK customers), we need payment details before we can accept your
extended registration. You can pay by credit card (Mastercard,
Eurocard, Access, Visa etc.), UK debit card (Switch, Connect etc.),
Eurocheque, UK cheque or Postal Order.

You may have already registered another HiSoft product under our
Gold or Silver service, in which case there is no need to fill out the
payment section.
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Colour Section

True Colour Mode

In True Colour mode you choose a partlcular colour (for the pen, rainbow, shadow
etc.) by using a colour wheel and its associated shade bar as shown below. The
Colour Options dialog also lets you set a colour using the RGB sliders.

— = EACT T

Pen olour

the Colour Options dialog in True Colour

Shadow Options
Colour: [ Direction:

II | .
JL

| ]
Pistance: 18

I Apply I

the Shadow Options dialog in True Colour
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TruePaint File Edit View Options Effects

C L
| o ' — =
P St : = e o
= —
L] General Options
Mrite Mode: Mirror:
Replace None -
Transparent Horizontal Y
XOR Vertical G”’-‘ S
Stencil Diagonal .
_ | 4-May \
Origin: % (s \
Top Left Hot Spot: : L
User | 0Ff ~Fl A
¥ Top 3 ; -
Side . 4
_| Segnente
Width: 10
Height: 25.
s loon: s \
| Cancel || Apply || 0K | :
°
setting up the Hot Spol to edit fme ¢ Telal Jrire ( olour)

TruePaint File Edit View Options Effects
BIRDBACK, TIF
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Palette Modes

[n Palette modes you choose a particu]ar colour (for the pen, rainbow, shadow etc.)
by selecting the one that you want from the displayed palette of colours. The Colour
Options dialog also lets you edit an existing, selected colour using the RGB sliders.

i | Colour Options

Red Green Blue

ainbow
2 Rainbow 2

(Spread || Default | Restore || OK |

the Colour Options dialegn 256 colours

% | Shadow Options

Colour: [ Direction:

Distance! .lli,.

|l:ul:el| | Apply | E

the Shadow Options dialog in 256 colours
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TruePaint File Edit View Options Effects
SANFRANL . JPB
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Index

A

About this manual 3
About TruePaint 108
Acceleration effect 75
Active window 9
Airbrush 47

attributes 47, 92

tool 91

true colour 48, 99
Alternate key 11, 16
Amiga IFF files 143
Angle, text 96
Animate 71, 120

Animated objects 28, 65, 74

Animation 65
files 148
keyboard shortcuts 71, 139
memory 66
options 69, 133
replay 71
techniques 73
Anti-aliasing 28
Apply button 13
Arcs 83
Area brush 49, 98
Area fill 42, 88
Area selection 51, 100
Arrow
lines 58, 80
pointer 10
Aspect ratio 42
preserving 135
Assembling
animations 74
pictures 54
Attributes, tools 13
AUTO folder 18

Background area 10
Background colour 45
changing 53
selecting 53

Backgrounds, drawing 73
Backups 2
Bézier curves 31
control points 32
drawing 84
joining 33
Bitmap fonts 29, 152
Black, adding 28
Blank disks 18
Blending 48, 99
colours 48,91
Bold text 95
Border area 22

Borders
around buttons 13
drawing 100
Bounce, animations 72
Boxes 41
grid 82,122
rounded 126
Bright colours 27, 44
Brush
attributes 48, 98
effects 47
range 49, 100
shape 49, 98
size 98
tool 97
Brush modes 99
area 49, 98
darken 99
leave range 100
lighten 99
outline range 100
pattern 99
replace range 49, 99
smear 99
smooth 48, 99
smooth tint 99
swap ranges 50, 100
tint 48, 99
Buttons in dialogs 13
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B C Control points 32, 84

Caching fonts 31, 151 ggpy.iz’ 13
Cancel button 13 E{: ksgz
Cartoon animation 66 Frames 68
Changes images 52
correcting 36, 116 palettes 131
losing 113 patterns 107
restoring 116 pictures 122
saving 111, 112, 115 Corners, rounded 126
Check mark 16 Cropping images 135
Circles 41 Crosshair 10
bl::fil; lslgpe 98 Cursor keys 11, 137
gerfect 42,125 C“; :’C‘is "
s Bézier 31,84
Clear pattern 107 3‘:,:::?1 Poinis 52, 84
N i ing 84
leeanng the image 37, 118 joining 33
Clipboard 51 tool 84
Close 111 Cut 52, 116
Close box 10 Cut and paste 51, 75
Co-ordinates 62, 121 . text 60
display 12 Cutting out shapes 53
ruler 124 :
Colour 24
background 45, 53 mD
changing 49, 99 Darken 99
distant 73 colours 28, 44
for detail 28 Default palette 131, 133
zf':f:é‘":‘,g 96 Define fill pattern 106
options 44, 128 Degas files 142
palettes 25, 44 Delay, animation 72
patterns 26, 106 Delete 37, 118
ranges 49, 131 Deselect area 51

selecting 27, 43,102

swapping 50, 100 Desk accessories 67, 108

tint 48, 99 Desk menu 108

transparent 53 Desktop

true colour 26 returning to 115
Colour options 46 running from 5, 7
Colour wheel 27, 103 windows 9

use of 43 Detail
Combining effects 56 adding 73

with colour 28

Comparing pictures 113, 116 working on 61

Compression, JPEG 144 Diagrams, labelling 58

Computer graphics 21 Dialis o b e 25

Connected lines 39 ialog boxes
tool 81

Constable 28

Control key 16

Directories 19
Disk drives 19

Page 156 Index TruePaint



Disks

copying 2

formatting 8, 18

installing 7
Display

fundamentals 21

tour of 9
Distance 73

perspective 40
Distorting size 56
Dither patterns 26
Dots 38

attributes 90

drawing 78

tool 89

types of 89

zoom mode 120

Dotted lines 80, 89
Double-clicking 13
Dragging windows 10
Drawing

3D objects 40

animated objects 65, 74

backgrounds 73

colour 43

curves 84

dots 38,78

freehand 36, 78

lines 39

shapes 39

text 58, 93

trees 41

waves 48

with the mouse 35
Drawing area 10, 36
Drawing modes 45
Drawing tools 12, 77

keyboard shortcuts 14, 138
Drive selection 19

mE
Edges 22

anti-aliasing 28

smoothing 48
Edit menu 116
Editing

animations 68

combining 56

distance 40, 73

dithering 26

flip 55, 134, 135

menu 134

mirror 57, 128

pattern 56, 135

perspective 40

rainbow 46

resize 55, 135

shadow 46, 132

shear 56, 136

stretch 55, 135

text 59, 60, 95

tint 48, 99

true colour 27

waves 48

wrinkle 56,136
EFMs 114,141

built-in 114

developers kit 149

folder 114, 115

loading 115

read me file 141

selecting 111, 113
EFMS folder 115
Ellipses 41, 85
Erasing 79, 99

selectively 50, 100
Exclusive or mode 127
Exiting

animate mode 72

TruePaint 115
Extensions, file names 20, 141

External file managers 114, 141

File extensions 20
recommended 141
File formats 114, 141

animation 148

selecting 113

still image 142
File menu 109
File names 20
File patterns 19
File selector 18

fill patterns 106 Fll(?s 20;1- 7
Effects 55 loading &
sl loading 6, 110
animation 65, 73, 75 palette 131
brush 47,99 pattern 107
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reading 2

saving 17,112

setup 133
Fill

button 107

tool 42, 88

true colour 88

zoom mode 120
Fill patterns 42, 105
Filled Shapes 41, 125
Film, moving 65
Flicker, interlaced 24
Flip 55, 134, 135
Floppy disk

backup 2

formatting 8, 18

installing on 8

running from 5

saving to 18
Flow rate 92
Folders 19

EFMs 115

entering 20

for pictures 18
Font caching 31, 151
Font GDOS 151
Fonts 29, 94

bitmap 29

outline 30

selecting 58
Foreground, adding 73
Formats 115, 141

selecting 113
Formatted disks 8, 18
Frame number 69
Frames 23, 65

adding 74

copying 68

creating 68

inserting 70

removing, 70

viewing 68, 69
Free Form 42, 125
Freehand drawing 36, 78
Full box 10
Full Screen 119

mode 11, 38

G

GDOS 151
GEM
dialog boxes 13
file selector 18
IMG files 143
windows 9

General options 126
Ghosted

menu items 16
text 95

GIF files 142
Graphics 21
Grey scale
IMG files 144
palettes 99
Grid 122
options 122
snap to 121
tool 82
use of 75

H-Flip 55, 134
H-Shear 56, 136
H-Wrinkle 56, 136
Hand pointer 11
Handles 51

scroll bar 11
Hard disk

installing on 7

saving to 18
Hexagons 41, 86
High resolution 22
Holes, avoiding 53
Hot spot 61, 128

Icons
animate 71
installing 7
program 5
toolbox 12, 77
zoom mode 119

IFF files 143

ILBM files 143

Image file formats 142
IMG files 143
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INF files 133
Installing

icons 7

TruePaint 7
Interlaced mode 23

flicker 24
Intervals, ruler 124
Italic text 95, 96

nJ

Jagged edges 22
anti-aliasing 28

JFIF files 144

Joining curves 33

JPEG compression 144

Keyboard shortcuts 137
animation 71, 139
menus 16
tools 14
zoom mode 119, 139

mL

Labelling diagrams 58
Landscape paintings 28
Leave range 100
Length of sequence 69, 70
Light text 95
Light, colours of 24
Lighten 99

colours 44
Line attributes 40, 79
Line thickness 40, 80
Lines 39

arcs 83

arrows 58, 80

connected 39, 81

curved 31, 84

dotted 80, 89

freehand 36, 78

grid 75, 82, 122

square 80
straight 39, 81
thickness 40, 80
tool 81

Loading
EFMs 115
palettes 131
patterns 107
pictures 6, 110

Looping animations 72

Magnify 61, 119

hot spot 61, 128
Manual summary 3
Masking out 60, 127
Matching colours 43, 96, 131
Memory

for animations 66

for display 22

requirements 1

running out of 114

saving 67, 114
Menus 15, 108

Desk 108

Edit 116

Effects 134

File 109

keyboard shortcuts 16, 137

Options 125

TruePaint 108

View 118
Mirror 57

effect 55, 134

options 128

text 60
Mistakes, correcting 36, 116
Mixing colours 24, 44, 129
Monitor display 23
Mosaic effect 135
Mouse

buttons 12

co-ordinates 62

drawing with 35

pointer 10
Movement 65, 75

joining 33, 80 Moving windows 10
e 0 Multicolour
perspective 40 feaxtttirgs 106
:25;3; gﬁ Multitasking 108, 115
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Naming files 20
Negative colours 127
NEOchrome files 145
New 35, 109

New frame after 68, 70

New frame at end 68, 70, 74

Nozzle size 47, 92
NTSC 23
Number of sides 41, 88

mO

OK button 13
Open 6, 110
Open As 111
Optical mixing 25
Options
general 126
menu 125
saving 133
Origin 62
setting 123, 127
top left 127
user 127
Outline 100
text 95
Outline fonts 30, 152
pasting 60
selecting 94
Overlay grid 75, 122
Overscan 22, 121
animation 71
full screen 119

mP

PAL
files 131
television 23
Palette 25
changing 44, 129
choice of 45
default 131
display 14, 43, 102
files 131
grey scale 99
in animations 74
restore 44, 131
swapping colours 50

true colour 103
when pasting 52
Paste 52, 117
text 60
Pastel colours 27
PAT files 107
Pattern 56, 135
brush mode 99
directory 19
display 14, 105
dither 26
editing 106
files 107
line 80
selecting 42
PC files 142
Pen colour130
indicator 101
selecting 43, 102
Pen tool 36, 78
Pentagons 42, 87
Perspective 40
animation 74

PI files 142

Pick colour 43, 49
rainbow 46
tool 96

Pictures 9
assembling 54
copying 122
creating 35
folder 6
loading 6
saving 17, 112

Pie charts 89

Ping-pong animations 72

Pixels 21, 28

Play icon 71

PNT files 146

Pointer, mouse 10

Pointillist style 25

Points, drawing 89

Polygons 41
attributes 41, 87
tool 86

Portability, files 141

Primary colours 24, 27
mixing 44, 129

Prism 24

Progress bar 18

Proportion 54
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changing 135
preserving 135
shapes 42, 125

HQ
Quit 115

Rainbow 126

colours 130

effects 46

range 49, 100

step 130
Range

brush modes 49

palette 131

rainbow 100
Rays 39

for perspective 40

tool 82
Re-colouring 49, 99
READ.ME file 2,7
READEFMS.ME file 141
Realism 73

perspective 40
Rectangle

brush 98
Rectangles 41

grid 82,122

rounded 126

selecting 51

tool 85
Red, green and blue 24

sliders 44, 129
Reflection 55, 57, 128
Registration card 1
Regular polygons 42, 86, 88
Remove frame 70
Repeating patterns 56, 105, 135
Replace

mode 59, 127

range 49, 99
Replaying animations 71
Requirements 1

Resolution 22, 28
changing 5
Restore palette 44, 131
Return key in dialogs 13
Revert 113
RGB 24
sliders 44, 129
Ring motion 65, 74
Rotate
180° 55

polygon 87
text 96

Rounded
boxes 126
line ends 80
Rubber band 39
Ruler 62, 123
options 124
Running TruePaint 5, 7

mS

Save 17,112
Save As 17, 112
Save Setup 133
Saving
memory 67, 114
options 133
palettes 131
patterns 107
pictures 17, 112
Scale, grid 123
Scaling 55, 74
effects 30
images 55
outline fonts 31
Scan lines 23
Screen display 9
fundamentals 21
Scroll bars 11
Scrolling 11
in full screen mode 38
Secondary colours 27
Segments 89
Select Visible 51, 118

Reset skew 96 Selecting
Resize 55, 135 ;ﬁ?h
Resjzing files 19
Hmags 30 menu items 15
windows 10 tools 12
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Selection 51

area 78
cancelling 51
tool 100
Selective erasing 50, 100

Semicircles 83, 89

Sequences, animation 65

Serial number 1
Seurat 25
Shade bar 28, 103
use of 43
Shading 48, 99
airbrush 91
colours 45
Shadow 46
options 132
text 60
Shapes
3D 40
boxes 41, 85, 126
circles 41, 85
cutting out 53
dots 89
drawing 39
filled 41, 88, 125
free form 42, 125
polygons 41, 86
segments 89
Shear 56, 136
text 96
Shift key 14

Shortcuts, keyboard 14, 16, 137
Single colour patterns.106

Sizing
images 30, 55
text 95
windows 10

Skew 136
text 96
Sliders 11
red, green and blue 129
Smear 99
Smooth 48, 99
movement 75
Smooth tint 99

Spray effect 47, 91

true colour 48, 99
Spread palette 131
Square

brush 98

grid 82,122

line ends 80

shapes 42, 125
Squares 41, 85, 87

tilted 86
Stars 42, 86, 89
Starting

a picture 35

TruePaint 5
Stencil 60, 127
Stretch 55, 135
Swap ranges 50, 100
Switchable options 16
Switching windows 9
Symmetry 57, 128
System requirements 1

T

Targa files 145
Technical support 153
Television 23, 65

colour 25

overscan 22
Text 58

attributes 58, 93

effects 59, 60, 95

fonts 29, 94

pasting 60

sizes 31

tool 93

transparent 59
TGA files 145
Thickness 80

changing 40

text 95
Ticked menu items 16
TIFF files 145

Tiled effect 56, 135

Snap to Grid 75, 121 T?nt_48, 99

Solid shapes 41, 125 Tinting 98

Spectrum, colours of 24,27, 103 Title bar 10

Speech bubbles 126 Tool attributes 13, 78

Speedo 151 keyboard shortcuts 138
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Toolbox 12, 77
drawing tools 12, 77
keyboard shortcuts 14, 77, 138
palette display 14, 43, 102
pattern display 14, 42, 105
zoom mode 119
Top left origin 127
TP menu 108
TPA files 67, 114, 148
TPI files 17, 114, 146
TPINST.PRG icon 7
Transparent
shapes 53
text 59
write mode 45, 127
Trees 41, 73
Triangles 41, 86
Trimming images 135
True Colour 26
files 145
palette 103
TruePaint
installing 7
menu 108
quitting 115
running 5, 7
screen display 9
TRUPAINT disk 8
TRUPAINT.INF file 133
TRUPAINT.PRG icon 5
Turner 28
Tutorials 35
Tweening 70

Underlined text 95
Undo 36, 116
using revert 113
Unselect area 51
Untitled windows 10, 109
saving 112
User origin 127
Using the manual 3

myv

V-Flip 55, 135
V-Shear 56, 136
V-Wrinkle 56, 136
Ventura 144

Version number 108
Video modes
changing 5
interlaced 23
overscan 23, 121
palette 25
true colour 26
Video recorder 66
View menu 118

Walking figure 65
Water-colour effect 99
Wave effect 48

White, selecting 53
Windows 9

closing 111

creating 35, 109

dialog boxes 13

palettes 44

toolbox 12, 77
Wrinkle 56, 136
Write modes 45, 127

replace 59, 127

stencil 60, 127

transparent 53, 59, 127

XOR 127

Write-protect tab 2, 18

m X

X co-ordinate 62
X interval 124

X scale 123
XIMG files 144
XOR mode 127

myY

Y co-ordinate 62
Y interval 124
Y scale 123

Zigzag effect 56, 136
Zoom 119

hot spot 128
keyboard shortcuts 119, 139
mode 61
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